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Summary and conclusions 

Technology in the form of a computer or word processor has been used by candidates with 

Additional Support Needs or disabilities as an Assessment Arrangement in SQA exams for many 

years, and digital question papers1 (DQPs) have been available from SQA since 2008. 

The majority of candidates currently use Windows laptops or computers, and the technology has 

proved reliable and practical for centres and candidates. In 2018, 59% of Scottish state schools 

requested DQPs (source: data from SQA). 

Chromebooks have been and are being purchased by some local authorities and schools in 

Scotland, and consequently SQA commissioned CALL to research the implications of using 

Chromebooks for Assessment Arrangements in SQA examinations. 

CALL has carried out research and testing, and liaised with colleagues in Google, schools and local 

authorities and software developers. This report summarises the status as of March 2020.  

The focus of this report is on candidates who require Assessment Arrangements, although the 

discussion is also relevant for candidates who do not, but who wish to use a Chromebook to type 

their answers in examinations. 

Technology used in examinations must meet SQA requirements in terms of security; centres’ 

requirements in terms of accessing DQPs and typing up or otherwise producing answers; and 

candidates’ requirements in terms of accessibility and usability. Regarding security, candidates must 

not be able to access information on the internet or other digital storage, and support tools such as 

Spellcheck cannot be used unless the candidate has permission to use them.  

Centres and candidates may use DQPs and/or technology in examinations to meet a range of 

different needs, and here we summarise our findings with respect to Chromebooks across three 

different Assessment Arrangement scenarios:  

 use of ICT to write answers (no DQP)  

 use of ICT with a ‘question-only’ DQP  

 use of ICT with a ‘question-and-answer’ DQP 

Technology is changing rapidly — over the course of this research there have been developments 

both in terms of the accessibility tools built into the Chrome OS and with apps and extensions 

available from third-party providers. This continually-changing technological context has delayed the 

publication of this document and does, in our view, contribute to uncertainty for staff and candidates 

regarding the use of Chromebooks in examinations because the devices and how they function 

appear to change, sometimes without warning. This situation is of course not confined to 

Chromebooks — it also applies to software and devices based on Windows and iOS.  

Consequently, the tools and systems described in this report will change. We hope that this report 

provides a summary of the current status for SQA, schools and teachers, local authorities, and 

software providers, and help to inform development of both technology and pedagogical practice.   

 

1 SQA (2020) Digital question papers, https://www.sqa.org.uk/sqa/30030.html  

https://www.sqa.org.uk/sqa/30030.html
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Use of ICT to write answers (no DQP) 

In this scenario, the candidate reads or accesses the conventional printed question paper and uses 

technology to type, dictate or otherwise record a response.  

SQA provides Digital answer booklets (DABs) in PDF and .docx format for candidates when using 

ICT to write answers. 

We tested a range of PDF readers and editors with the SQA Digital answer booklets in PDF and 

found that none of them offered a satisfactory solution for use in examinations. Details are in the 

later section on SQA DABs in PDF.  

We tested a range of word processors and other writing tools commonly available on Chromebooks 

in schools, including Google Docs2, Google Office File Editor3, Google Forms4 and Microsoft Word 

(app and Online). We also reviewed paid-for software such as DocsPlus5 and DigiExam6. The 

results are given in the section on Use of ICT to write answers (no DQP). 

We found that the SQA Digital answer booklets (DABs) in .docx format do not function correctly in 

any of the word processors tested apart from the Microsoft Word app7. Candidates could however 

use a word processor such as Google Docs without typing into a DAB. 

A key requirement for centres is to be able to restrict access to Spellcheck or other literacy tools 

where candidates do not have permission to use them. Some supports, such as dictionary or 

definition tools, are not allowed regardless of whether the candidate has permission to use 

Spellcheck (apart from in specific subjects or by candidates with English as an Additional Language 

(SQA, 2019a, 2019b), and so centres must be able to disable such features on Chromebooks. 

No Spellcheck 

We found that Google Docs may provide a solution for candidates who are not permitted to use 

Spellcheck or other literacy supports. When the device is disconnected from the internet, the 

support tools do not function. It may also be possible to configure the online Google Docs using the 

Google Admin Console such that the support tools are unavailable for use. 

With Google Office File Editor and Google Forms we did not find a mechanism to securely disable 

the Spellcheck: while it can be turned off in Settings on the Chromebook, the candidate could turn it 

back on.  

DocsPlus and DigiExam, which are paid-for products, have the facility to disable Spellcheck, and so 

may offer the required functionality for centres. 

 

2 Google Docs https://www.google.com/docs/about/ 

3 Google Office File Editor, https://support.google.com/chromebook/answer/2481498?hl=en-GB  

4 Google Forms https://www.google.co.uk/forms/about/ 

5 DocsPlus for Chromebook https://www.cricksoft.com/uk/docsplus/chromebook 

6 DigiExam https://www.digiexam.com/ 

7 Microsoft Office for Android https://products.office.com/en-gb/mobile/office-mobile-apps-for-android 

https://www.google.com/docs/about/
https://support.google.com/chromebook/answer/2481498?hl=en-GB
https://www.google.co.uk/forms/about/
https://www.cricksoft.com/uk/docsplus/chromebook
https://www.digiexam.com/
https://products.office.com/en-gb/mobile/office-mobile-apps-for-android
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In conclusion, for candidates who do not have permission to use Spellcheck, centres might 

consider: 

 Google Docs2 used offline or with restricted access to the Google Docs server 

 DocsPlus5 

 DigiExam6 

Permission to use Spellcheck 

Where candidates do have permission to use Spellcheck, Voice Typing (Computer Dictation) or 

other accessibility tools (which is likely for candidates who require Assessment Arrangements), we 

found that in Google Docs it was not possible to enable Spellcheck while also disabling the Define 

and Explore functions that are not permitted. Unless this can be done, Docs is not suitable for use in 

examinations. 

Candidates who have permission to use Spellcheck could use Google Forms and Google Office File 

Editor with the built-in Chromebook Spellcheck. 

DocsPlus provides accessibility and literacy support tools that can be controlled using Exam Mode, 

so it may meet the needs of centres, while DigiExam also provides security and an optional text 

reader and Spellcheck. 

For candidates who do have permission to use Spellcheck, consider: 

 Google Forms4 

 Google Office File Editor3 

 DocsPlus5 

 DigiExam6 

Use of ICT with ‘question-only’ digital question papers 

In this scenario, candidates read from a question-only digital question paper, perhaps with support 

from accessibility tools such as a text reader, and answer using a word processor or text editor as 

discussed in the previous section. 

We tested DQPs with several Chromebook PDF Viewers including: Chrome Browser; Chrome PDF 

Viewer; DocsPlus; Kami; Texthelp PDF Reader; Snap&Read and Xodo. Out of these, centres might 

consider: 

 Chrome PDF Viewer8 

 Kami for Schools (premium subscription version)9 

 Texthelp PDF Reader10 

 

8 Chrome Download a file https://support.google.com/chrome/answer/95759?hl=en-

GB&co=GENIE.Platform=Desktop  

9 Kami https://www.kamiapp.com/  

10 Texthelp PDF Reader https://www.texthelp.com/en-gb/company/education-blog/april-2019/transform-pdfs-

with-the-texthelp-pdf-reader/ 

https://support.google.com/chrome/answer/95759?hl=en-GB&co=GENIE.Platform=Desktop
https://support.google.com/chrome/answer/95759?hl=en-GB&co=GENIE.Platform=Desktop
https://www.kamiapp.com/
https://www.texthelp.com/en-gb/company/education-blog/april-2019/transform-pdfs-with-the-texthelp-pdf-reader/
https://www.texthelp.com/en-gb/company/education-blog/april-2019/transform-pdfs-with-the-texthelp-pdf-reader/
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for accessing question-only DQPs in conjunction with typing or producing answers in a word 

processor.  

The other readers all have limitations that in our view make them currently unsuitable for use in 

examinations.  

With the suggested tools, candidates with, for example, visual impairment can use zoom, 

magnification and high contrast adjustments to read the paper; candidates with reading difficulty can 

use text-to-speech to read the questions; candidates with physical disabilities can use a keyboard or 

mouse to navigate the paper. 

(A limitation with all the PDF readers is that the CereProc Scottish Computer Voices11 (Stuart, 

Heather and Ceitidh, the Gaelic voice, and the new Andrew and Mairi child voices) are not currently 

available for Chromebooks. The Rhona Scottish voice from Acapela can, however, be purchased at 

a cost of around £6 per user12.) 

Use of ICT with ‘question-and-answer’ digital question papers 

In this scenario candidates read the digital question paper and type or dictate into on-screen answer 

boxes within the paper itself. 

Of the PDF readers tested, only DocsPlus and Kami provide an AutoSave function, which we regard 

as essential for examinations. 

However, both DocsPlus and Kami have drawbacks: DocsPlus seems to limit the amount of text 

that can be typed into an answer box, while Kami uses the Chromebook Spellcheck, which we have 

not found a secure mechanism of disabling, so it is not suitable for candidates who do not have 

permission to use Spellcheck.  

We therefore do not recommend Chromebooks for use with SQA question-and-answer papers at 

this time. 

None of the six Chromebook PDF readers offer the same range of features and facilities that are 

available on Adobe Reader on Windows.  

Chromebook accessibility options 

Chromebooks have a number of built-in accessibility options13, including: 

 zoom and magnify 

 high-contrast mode 

 large mouse pointer 

 Select and Speak (text reader) 

 

11 Scottish Computer Voices, http://www.thescottishvoice.org.uk/home/  

12 Acapela voices for Chromebooks https://www.acapela-group.com/solutions/acapela-voices-for-

chromebooks/ 

13 Turn on Chromebook accessibility features https://support.google.com/chromebook/answer/177893?hl=en-

GB 

http://www.thescottishvoice.org.uk/home/
https://www.acapela-group.com/solutions/acapela-voices-for-chromebooks/
https://www.acapela-group.com/solutions/acapela-voices-for-chromebooks/
https://support.google.com/chromebook/answer/177893?hl=en-GB
https://support.google.com/chromebook/answer/177893?hl=en-GB
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 ChromeVox, a screen reader 

 on-screen keyboard 

 voice typing (computer dictation) 

 AutoCorrect,  

 word prediction 

 Spellcheck.  

Other accessibility features, such as screen tinting or text readers, can be added with extensions; 

some free, some at a cost. Some accessibility tools, such as eye-gaze and switch access, are not 

available on Chromebooks.  

Conclusions 

Chromebooks may be suitable devices for use by candidates who wish to use a word processor in 

an examination. To meet security requirements regarding Spellcheck and literacy supports, centres 

must use a word processor or text editor without Spellcheck, or purchase commercial 

assessment/examination software. It may be possible to develop technical solutions to selectively 

enable and disable literacy support tools. 

Chromebooks may be suitable also for candidates who need to view and read ‘question-only’ digital 

question papers (subject to addressing the security considerations above). 

For candidates who need to access ‘question-and-answer’ digital question papers, the current tools 

available on Chromebooks are in our view not yet suitable.  

In all scenarios, centres will have to configure the Chromebooks to prevent candidates from 

accessing information from the internet or on other digital sources. 

Areas for development 

Development work that could be considered by stakeholders to improve the current situation 

regarding use of Chromebooks by candidates who require Assessment Arrangements includes: 

 Development of software tools to disable Spellcheck, AutoCorrect, definitions, word prediction 

and other literacy supports to enable centres to meet SQA security requirements. 

 Development of PDF reader and access tools to improve the user experience and accessibility 

options. 

 Publishers of text reader extensions (including Google) might consider licencing and integrating 

computer voices with Scottish accents and a Scottish Gaelic voice. 

 Development of digital answer booklet templates for use in Google Docs. 

 Action research and collaboration with centres regarding the practical application of 

Chromebooks for candidates who use Assessment Arrangements.  

 Development and publication of guidance on administration of Chromebooks in examinations to 

meet security and accessibility requirements.  
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The research 

Research questions 

The purpose of this investigation is to explore the use of Chromebooks for candidates who use 

Assessment Arrangements in SQA National 5, Higher and Advanced Higher examinations. More 

specifically, we wished to find out: 

 How can Chromebooks be configured to meet administration and security requirements, in 

terms of restricting access to information sources and support tools such as spellcheckers that 

may not be permitted in the examination. 

 How can Chromebooks be used to open and access digital question papers in PDF.  

 How candidates can type or record their answers using SQA Digital answer booklets, or a word 

processor or text editor.  

 What accessibility options are available for candidates who require, for example, text-to-speech 

to read questions, or literacy support tools to record answers. 

Methods 

The CALL team used several methods throughout the research: 

 A set of Chromebooks was kindly provided to CALL by Stephanie Shipley of Prowise, in 

conjunction with Google, to research and test options for configuring Chromebooks.  

 Leigh Craig and Louise Jones, formerly of Google, provided Chrome OS Management Licenses 

for the devices and arranged access to Google Classroom and G Suite. 

 Discussions and meetings took place with representatives of Google and some of the 

developers of the technologies discussed in this report.  

 CALL staff joined and participated in the Google Education Group (GEG) Scotland14.  

 Desk and internet-based research.  

 Testing of apps and extensions for accessing digital question papers, Digital answer booklets, 

and options for typing answers. 

 Testing of accessibility apps and extensions.  

The work began in 2018 and the report was completed in August 2019. For a number of reasons 

including the Covid-19 pandemic there was a delay in gaining approval to publish the report. 

  

 

14 Google Education Group (GEG) Scotland. https://drive.google.com/file/d/11P7Yu--

H6ZAY5tLueuVSlDfV1NMfv1Sz/view  

https://drive.google.com/file/d/11P7Yu--H6ZAY5tLueuVSlDfV1NMfv1Sz/view
https://drive.google.com/file/d/11P7Yu--H6ZAY5tLueuVSlDfV1NMfv1Sz/view
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Technology as an Assessment Arrangement 

The purpose of Assessment Arrangements is to ‘provide candidates with an equal opportunity to 

demonstrate their attainment without compromising the integrity of the assessment’ (Scottish 

Qualifications Authority, 2017a). 

Assessment Arrangements can be used by candidates who are disabled or who have been 

identified as having particular difficulties with accessing the assessment using the standard 

arrangements (Scottish Qualifications Authority, 2017a). 

Assessment Arrangements are requested to reflect the needs of the candidate and the specific 

assessment. A candidate may use different types of Assessment Arrangement in different 

examinations.  

For example: 

 A candidate with dyslexia might use a coloured overlay to help read the question paper, and 

extra time to write up answers. 

 A candidate with a visual impairment might request a question paper in Large Print or Braille. 

 A candidate with a hearing impairment may use sign language to access an assessment task. 

 A candidate with a physical disability or handwriting difficulties might use technology or a scribe 

to record their answers. 

The use of ICT and technology is a type of Assessment Arrangement. For example: 

 A candidate with dyslexia might use a digital question paper and change the screen colours or 

use a computer text reader to read the questions. 

 A candidate with a visual impairment might access a digital question paper on a computer or 

tablet and zoom in to magnify the questions. 

 A candidate with a physical impairment who cannot handwrite or physically manipulate the 

question paper might use technology to access the question paper and write their answers.  

 A candidate with a significant spelling difficulty night use speech recognition to record their 

answers. 

One of the principles governing the use of Assessment Arrangements is that the integrity of the 

qualification must be maintained. With respect to technology, the centre must ensure that 

candidates cannot access any software tools or facilities that might give an unfair advantage over 

other candidates. For example, candidates should not be able to access the internet to research or 

use literacy support tools such as spellcheckers or speech recognition unless these have been 

requested as an Assessment Arrangement (Scottish Qualifications Authority, 2017b). 
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Security requirements 

SQA policy on use of technology in examinations (Scottish Qualifications Authority, 2017c) requires 

devices to be made secure so that candidates cannot access information or supports 

inappropriately. Software tools and facilities that could give the candidate access to information that 

could confer an unfair advantage should not be available to the candidate. 

In practice this involves: 

 preventing access to the internet or only allowing access to specific services required for the 

examination 

 preventing access to network folders, USB sticks, Bluetooth, AirDrop or any other storage or 

communication facility 

 preventing access to tools that could give the candidate an unfair advantage such as 

Spellcheck, dictionary, definitions, thesaurus, AutoCorrect or voice typing 

Spellcheck and literacy support tools 

SQA policy in examinations is that Spellcheck, Voice Typing or other facilities that support spelling 

and grammar can only be used where the centre has requested and received permission for the 

candidate and the examination. Otherwise, Spellcheck and literacy support tools must be disabled.  

To help centres manage the use of spellcheckers, SQA produces ‘spellcheck enabled’ and 

‘spellcheck disabled’ digital question papers and answer booklets in PDF. When the ‘spellcheck 

disabled’ files are opened with Adobe Reader on PC, the spellcheck does not function. However, 

with Chromebooks (and iPads), spellcheck still operates on ‘spellcheck off’ digital papers, so other 

techniques are required to restrict access to the spellcheck. 

With digital answer booklets in .docx format, or use of word processor to type answers, school 

technicians and analysts use group profiles to disable spellchecking or remove the spellchecker 

dictionaries from Word so that the spellchecker does not function. This requires technical and 

network expertise and so is not a measure that can usually be undertaken by teaching staff or 

invigilators.  

To use Chromebooks in examinations, centres must be able to restrict access to the following 

facilities that are provided as standard on the devices: 

 Spellcheck 

 AutoCorrect 

 Predictive text 

 Dictation / voice typing 

 ‘Explore’ and ‘Define’ tools. 
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Technology management in SQA examinations 

Organising computers or devices for use as Assessment Arrangements in SQA examinations 

involves: 

 physically locating devices in quiet locations where candidates will not be distracted, or distract 

other candidates 

 ensuring that security requirements are met (see below) 

 arranging procedures for distributing Digital Question papers if these are going to be used 

 arranging printers and procedures for printing 

 installing or giving access to the necessary software, apps and extensions for reading papers 

and for generating responses 

 installing or making available the necessary accessibility software, apps and extensions for 

reading papers and for generating responses 

Exam profiles and accounts 

The most efficient approach to security in examinations for centres that use Windows machines is to 

create ‘exam profiles’ with group policies where the device is configured to only allow the software 

required for the examination and access to the network folder containing the DQP or DAB. The 

exam profile prevents access to the internet or to other file storage sources. It can also be used to 

disable the spellchecker and other literacy support tools built into Microsoft Word, that are not 

permitted in the examination. 

In the case of Chromebooks, there are several techniques that may offer equivalent functionality 

and these are discussed in the section on Technical administration of Chromebooks in SQA 

examinations.  

  



10 

Scenarios for use of technology as Assessment 
Arrangements 

There are three main scenarios where Chromebooks might be used as part of an Assessment 

Arrangement. 

Use of ICT to write answers (no DQP) 

In this scenario, the candidate reads the questions from the hard copy question paper and writes or 

dictates answers using a word processor or text editor on the Chromebook. SQA do provide Digital 

Answer Booklets (DABs) for candidates to type their answers however they have limitations (see 

below) and complications on Chromebooks and we do not recommend their use.  

Some candidates will have permission to use Spellcheck and some candidates will not; for the 

latter, the centre must restrict access to Spellcheck or any other tools such as Voice Typing 

(computer dictation), thesaurus or dictionary that could give an unfair advantage. Candidates with 

additional support needs may require specific support tools such as computer dictation or word 

prediction. Permission to use these in the examination must be requested with the SQA AAR 

system. 

 

Use of ICT with question-only Digital Question Paper 

In this scenario, the candidate reads the questions from a digital question paper in PDF and writes 

answers using a Digital Answer Booklet, word processor or text editor on the Chromebook. 

Candidates may use accessibility tools and options, such as zoom, a text reader, or coloured screen 

overlay to read the DQP. 

Again, some candidates may require access to a spellchecker or other writing supports, while others 

should not have access. The use of writing supports such as computer dictation or word prediction 

may be requested from SQA. 

Figure 1: Digital Answer Booklet 
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Use of ICT with question-and-answer Digital Question Paper 

In this scenario, the candidate reads the questions and inserts answers directly into ‘answer boxes’ 

in the digital question paper PDF.  

The candidate may use accessibility tools and options, such as zoom, a text reader, or coloured 

screen overlay to read the DQP, and writing supports such as spellchecker, word prediction or 

speech recognition (where permission has been sought and granted) to insert answers.  

  

 

 

 

 

 

 

 

 

Figure 3: Question-and-answer DQP 

Figure 2: Question-only DQP 
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Chromebooks 

Chromebooks15 are laptop or laptop/tablet computers that run the Google Chrome browser. They 

are relatively inexpensive, are light and have good battery life, and for large scale deployment, they 

are claimed to require fewer technical staff to maintain and update (O’Donnell and Perry, 2012; 

Google, 2018a) and therefore may be attractive for schools and local authorities wishing to provide 

learners and staff with large numbers of personal devices (Molnar, 2014; Ahlfeld, 2017). 

Chromebooks are available from most of the major technology manufacturers including, for 

example, HP, Samsung, Asus and Toshiba.  

In use, learners typically use digital tools that operate over the internet rather than being installed on 

the device itself. Google offers G Suite for Education16 which includes tools for word processing 

(Docs), spreadsheets (Sheets), presentations (Slides), email (Mail), video conferencing (Meet), 

virtual classroom management (Classroom), quizzes (Forms) and assignments, organisation and 

administration, and the Suite is available for schools in Scotland through Glow17. It is possible to 

work offline by downloading an ‘app’ version of these tools. 

Chromebooks are in use in some schools and local authorities in Scotland in significant numbers: 

Highland, Aberdeen, Stirling and West Dunbartonshire have all invested in the devices (Highland 

Council, 2015; West Dunbartonshire Council, 2016; Stirling Council, 2018).  

The picture across Scotland remains mixed with most local authorities maintaining Windows OS as 

the default system for devices, while Glasgow and Scottish Borders have both begun programmes 

to provide iPads to every learner in P6 and above (Glasgow City Council, 2018; Scottish Borders 

Council, 2019). 

A number of centres contacted CALL Scotland for advice regarding the use of Chromebooks as an 

Assessment Arrangement in SQA examinations, and so as part of the partnership programme with 

SQA, CALL has undertaken this research into use of Chromebooks for accessing digital question 

papers and answer booklets. 

Chromebook Accessibility Features 

Chromebooks, like Windows and iOS devices, have built-in accessibility tools that may be helpful for 

candidates who require Assessment Arrangements in examinations18. These include: 

 zoom in/out 

 screen magnifier 

 high contrast mode where the screen colours are inverted 

 Select and Speak, a computer text reader 

 ChromeVox, a screen reader for users with significant visual impairment 

 reading the screen using a Braille display 

 Sticky Keys, for typing key combinations with a single finger 

 

15 https://www.google.com/chromebook/  

16 https://edu.google.com/products/gsuite-for-education/ 

17 https://glowconnect.org.uk/g-suite-for-education/ 

18 Chromebook Accessibility. 

https://support.google.com/chromebook/topic/6323347?hl=en&ref_topic=3399710  

https://www.google.com/chromebook/
https://edu.google.com/products/gsuite-for-education/
https://glowconnect.org.uk/g-suite-for-education/
https://support.google.com/chromebook/topic/6323347?hl=en&ref_topic=3399710
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 Voice Typing (computer dictation or speech recognition) for people who cannot use the physical 

keyboard 

 an on-screen keyboard 

Craig Mill at CALL Scotland has created a poster19 that summarises the main accessibility options. 

 

 

19 Chromebook Accessibility and Learning Tools https://www.callscotland.org.uk/common-assets/cm-

files/posters/chromebook-accessibility-and-learning-tools.pdf  

https://www.callscotland.org.uk/common-assets/cm-files/posters/chromebook-accessibility-and-learning-tools.pdf
https://www.callscotland.org.uk/common-assets/cm-files/posters/chromebook-accessibility-and-learning-tools.pdf
https://www.callscotland.org.uk/common-assets/cm-files/posters/chromebook-accessibility-and-learning-tools.pdf
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Other built-in Chromebook features that can be helpful for candidates in an examination include: 

 spellchecker20 

 Automatic Substitution (AutoCorrect) 

 Auto-capitalisation 

 Word prediction. 

Additional accessibility tools can be added to the Chromebook in the form of ‘apps’ or ‘extensions’ 

available from the Google Play Store. Some of these are free while others are priced as a one-off 

purchase or a subscription. CALL Scotland have created a poster listing Chromebook accessibility 

tools for learners with dyslexia that can be downloaded from the CALL website21. 

 

 

Accessibility tools and features currently lacking in Chromebooks are: 

 MouseKeys, to control the mouse pointer with the keyboard, available in Windows and iOS. 

 Eye-gaze access: eye gaze cameras cannot currently be used with Chromebooks. 

 Full access with switches. Switch access is built into Windows, MacOS and iOS. 

 Full featured screen magnification functionality comparable to, for example, Windows magnifiers 

such as SuperNova22 

 

20 Chromebook Language and Spellcheck https://support.google.com/chromebook/answer/1059490?hl=en-

GB  

21 Chomebook Apps and Extensions for Learners with Dyslexia. 

http://www.callscotland.org.uk/downloads/posters-and-leaflets/chromebook-apps-and-extensions-for-learners-

with-dyslexia/  

22 SuperNova Magnifier & Screen Reader https://yourdolphin.com/en-gb/products/individuals/supernova-

magnifier-screen-reader 

Figure 4: Chrome Apps and Extensions for Learners with Dyslexia 

https://support.google.com/chromebook/answer/1059490?hl=en-GB
https://support.google.com/chromebook/answer/1059490?hl=en-GB
http://www.callscotland.org.uk/downloads/posters-and-leaflets/chromebook-apps-and-extensions-for-learners-with-dyslexia/
http://www.callscotland.org.uk/downloads/posters-and-leaflets/chromebook-apps-and-extensions-for-learners-with-dyslexia/
https://yourdolphin.com/en-gb/products/individuals/supernova-magnifier-screen-reader
https://yourdolphin.com/en-gb/products/individuals/supernova-magnifier-screen-reader
http://www.callscotland.org.uk/downloads/posters-and-leaflets/chromebook-apps-and-extensions-for-learners-with-dyslexia/
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Use of ICT to write answers (no DQP) 

Many candidates who use technology as an Assessment Arrangement in examinations utilise a 

word processor, perhaps with assistive support tools, to type up their answers.  

This group of candidates do not require digital question papers because they can access and read 

the standard printed question paper. They use technology to write and type their answers to 

alleviate physical difficulties with handwriting, or to utilise literacy support tools to address difficulties 

with spelling, for example.  

There are also many candidates who do not have an additional support need or disability, and who 

choose to use ICT instead of handwriting. As devices are provide to more and more learners on a 

1:1 basis, this is likely to become the largest group of candidates who use Chromebooks in 

examinations — provided that the devices can be managed and configured to meet the needs of the 

candidates; centre’s processes; and SQA’s security requirements.   

Digital answer booklets (DABs) 

SQA provide Digital answer booklets (DABs) for candidates to use when typing or dictating 

answers. SQA recommends that centres use DABs because the printed outputs can be scanned 

and processed electronically by the SQA e-marking system. Use of DABs is, however, not 

compulsory and candidates may use any word processor or text editor if necessary. DABs are 

provided in PDF and Word (.docx) format. These are supplied on the CD with the DQP or can be 

downloaded from www.sqa.org.uk/digitalquestionpapers. 

SQA DABs in .docx format 

SQA provides DABs in .docx format but they are not usable in either Google Docs or the 

Chromebook Office Editor (the Google word processors provided for Chromebooks) or Word Online, 

the online version of Word. The .docx format apps can be used with the Microsoft Word Android app 

- if the Chromebook can run Android apps. 

In Google Docs, the instructions and text boxes required for the candidate information on the front 

page are either missing or appear jumbled and disjointed, and the fiducial marks at the corners of 

the pages are not shown at all. The text in the instructions on the front page cannot be selected and 

read out with a text reader.  

Note that the SQA DABs in .docx format are not usable in many other word processors and text 

editors, such as WordPad on Windows, or Notes on iPad either, and they are also not accessible for 

some candidates with additional support needs even when opened in Word on a Windows machine. 

For example, the DABs do not display correctly when viewed in the Word Web Layout on Windows, 

and they are not accessible with a screen reader such as Jaws for Windows. 

We believe that these layout problems are due to the use of floating text boxes and images on the 

front page of the DQP, which are employed to ensure that the relevant information is in the correct 

place to be read by the SQA electronic scanning and digitising process. 

http://www.sqa.org.uk/digitalquestionpapers
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It is possible that Google will develop Docs to display floating text boxes: in 2016, Word format 

DABs would not display accurately in either Pages or Word on iPad, but by 2018 they had become 

functional, although not perfect. Alternatively, if the SQA eMarking specification can be altered it 

may be possible to develop DABs that function correctly in Google Docs as well as Microsoft Word.  

SQA DABs in PDF 

DABs in PDF can be opened and used on Chromebooks with the apps/extensions described in the 

next section although the user experience with many of the tools is lacking. More details on the PDF 

readers discussed can be found later. 

Chrome PDF Viewer 

DABs in PDF format can be opened with the PDF Viewer that is available on Chromebooks as 

standard. Answers can be typed in or dictated, saved and printed. The main limitations are that 

there is no AutoSave so candidates must remember to save their answers manually as they work, 

and we could not get the Chrome Spellcheck to operate.  

 

 

Figure 5: DAB in .docx format opened in Google Docs 

Figure 6: Reading DQP and typing answers into a DAB with the Chrome PDF Viewer 
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DocsPlus 

DocsPlus can access a PDF DAB, but we found that after typing in a few paragraphs the text cursor 

became misplaced so that accurate editing was impossible, which meant there was a limit to how 

much text could be entered. There is no Autosave and the Spellcheck does not function in the 

DocsPlus PDF Reader. 

 

 

Kami 

With Kami, answers can be typed into a DAB, saved and printed. There is AutoSave and the 

Chrome Spellcheck operates in the DAB. However, the answer boxes are transparent, which may 

be disconcerting for candidates. 

 

 

Texthelp PDF Reader  

Candidates cannot type into the answer boxes in the PDF DAB with PDF Reader. Candidates could, 

however, manually draw a text box ‘on top’, but this adds complexity and time for the user and 

requires accurate use of a mouse or pointing device, which is difficult or impossible for some 

candidates. It also risks answers not being positioned correctly — if the candidate places an answer 

or part of an answer outside the area of the page that is scanned by the e-marking system it will be 

Figure 7: DocsPlus with PDF DAB 

Figure 8: A PDF Digital Answer Book with Kami 
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not be seen by the marker. PDF Reader saves a new file every time the candidate saves, which 

generates a large number of copies of the file, and there is no Autosave facility. 

 

 

Xodo 

The Xodo web app can be used to type answers into a PDF DAB. There is no Autosave, but 

provided the DAB is saved the Google Drive, the users can manually save as they work through the 

examination. Although spelling errors are underlined in red there does not appear to be an actual 

spellchecker. 

 

 

Spellcheck in PDF DABs 

SQA provides PDF DABs in ‘spellcheck on’ and ‘spellcheck off’ variants: this helps centres to 

manage the use of spellcheckers when Windows computers are used, because the spellchecker in 

Adobe Reader on Windows computers does not function in the ‘spellcheck off’ papers.  

However, with the Chromebook PDF tools (and iPads), the spellchecker functions in both 

‘spellcheck on’ and ‘spellcheck off’ PDFs. Therefore, another method is required to prevent users 

from accessing the spellchecker and any other literacy support tools such as AutoCorrect, word 

Figure 9: The Typewriter tool can draw answers 'on top' of the DAB 

Figure 10: Xodo 
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prediction and speech recognition, for the candidate’s exam account. We are not aware of a solution 

to this problem. 

Summary 

None of the options for accessing SQA Digital Answer Booklets in PDF are in our view satisfactory 

for use in high-stakes SQA external examinations.   

Digital answer booklets for Chromebooks 

Given the issues with DABS, we created a sample DAB for Google Docs that can be downloaded 

from CALL’s Digital Assessment website23. The front page has the required information and may be 

edited to suit the subject and paper. 

 

 

The Google Docs DAB is based on an SQA file and uses the same table structure for inserting 

answers. A header has been added for candidates to insert their candidate ID. 

 

23 Adapted Digital Assessments https://www.adapteddigitalexams.org.uk/Home/  

Figure 11: DAB template for Google Docs (front page) 

https://www.adapteddigitalexams.org.uk/Home/
https://www.adapteddigitalexams.org.uk/Home/
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Chromebook word processors and text editors 

Although the SQA DABs in PDF or .docx format are not usable on Chromebooks, candidates could 

use the accessible alternative DAB with a word processor to type up their answers: for example, 

Google Docs, Google Forms, Microsoft Word app/online, DocsPlus or a bespoke assessment 

product such as ChromeEx or DigiExam. 

Considerations for use in examinations are: 

 security — it must be possible to prevent access to the internet and to disable spellchecking and 

other supports such as Automatic Substitution (AutoCorrect), if the candidate is not permitted to 

use them 

 candidates should not have access to dictionary, thesaurus or online look-up or research tools 

 Autosave — answers should be saved automatically 

 compatibility with accessibility tools — it should provide or allow candidates to use accessibility 

tools to for example read text, change colours, use screen tint overlays, or use voice typing 

 writing facilities — text editing and formatting; options for generating mathematical expressions 

and for drawing 

Detailed research and testing of all the available apps and extensions was beyond the scope of this 

small project, so we summarise the results of our research with the more common options here.  

Google Docs 

Google Docs (Google, 2019a) is a full featured word processor and we will not list all the tools and 

functions that are provided: refer to Google support online and the Docs Help for detailed 

information. Here we focus on features of Google Docs that are of particular relevance for learners 

with additional support needs who may wish to use the software as an Assessment Arrangement. 

Magnification and colour 

Candidates with visual support needs can use the zoom facility to enlarge the text. The maximum 

zoom with Google Docs is 200%: candidates who require larger text than this will need to use the 

Figure 12: DAB template for Google Docs 
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Chrome Magnify function in the Accessibility Settings. Candidates who prefer a coloured 

background can alter the page colour in File > Page Setup. 

 

 

Spellcheck 

To spell check, right click on a word or press Tools > Spelling or CTRL-ALT-X. The red underline of 

suspect words can be switched off in the settings.  

 

 

Voice Typing 

Voice Typing (computer dictation, or speech recognition) is available from Tools > Voice Typing or 

by pressing CTRL+AT+S. Voice Typing requires an internet connection to function. Feedback from 

practitioners suggests that Voice Typing is easy to use, tolerant of accents and could be of great 

benefit for candidates who have difficulty with typing or spelling. Learners still have to use the 

mouse or keyboard to edit and correct text, so it is not suitable for candidates with physical support 

needs who require ‘hands-free’ control. Voice Typing is not suitable for candidates with physical or 

motor difficulties who need to edit text or control the computer by voice, because it does not have 

Figure 13: Changing page colour with Docs 

Figure 14: Google Docs Spellcheck 
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that functionality, but feedback from practitioners suggest that it is proving to be very helpful for 

learners with spelling or literacy difficulties.  

In the examination context, there may be security questions to be considered given that Voice 

Typing requires to access the internet, and that candidates’ audio responses are transmitted to a 

Google server (of undefined geographic location), recognised and converted into text, which is then 

transmitted back over the internet to the candidate’s Chromebook.  

 

 

Automatic Substitution (AutoCorrect) 

Google Docs has other tools to support writing, which are found in Tools > Preferences. The 

Automatic Substitution can be helpful for candidates with spelling difficulties as it can be used to 

autocorrect spelling mistakes. Note that this still appears to function when the device is 

disconnected from the internet, so centres must ensure that candidates who do not have permission 

to use Spell Check cannot access it (see below).  

 

 

Select and Speak 

The Chrome Select and Speak text reader and ChromeVox screen reader can both be used with 

Google Docs. See Google’s Hear text read aloud for details. 

To read with Select and Speak, hold down the Search key and select the text. The text reader will 

read it out, highlighting each word as it reads. The voice, voice characteristics and highlight colours 

can be adjusted in the Accessibility Settings.  

Figure 15: Google Docs Voice Typing 

Figure 16: Google Docs automatic word substitution (AutoCorrect) 

https://support.google.com/chromebook/answer/9032490?hl=en-GB
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Dictionary 

The Dictionary tool offers definitions. Select and speak can be used to read the definitions. 

 

 

Explore  

The Explore tool searches the internet for information or images. 

 

 

Exam security with Google Docs 

Disabling Spellcheck and literacy tools: Candidates who are not permitted to use Spell Check 

should not have access to it or to Voice Typing or the other writing supports. Some of these tools 

are disabled when the device is disconnected from the internet and so this offers a partial solution to 

security requirements (Table 1). 

Figure 17: Select and Speak in Google Docs 

Figure 18: Dictionary definitions 

Figure 19: Google Docs Explore tool 
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Google Docs Tool Works Offline? 

Spelling and Grammar No  

Explore No 

Define / Dictionary No 

Voice Typing No 

Automatic capitalisation Yes 

Smart quotes Yes  

Automatic Substitution (correction) Yes  

 

Automatic Substitution (AutoCorrect) and capitalisation still function when the device is not 

connected to the internet and in our tests we found that we could disable them by following this 

procedure: 

 Connect the Chromebook to the internet and disable Automatic Substitution and Capitalisation in 

Tools > Preferences (Figure 20).  

 Remove access to the internet. 

 Automatic Substitution will not operate and the Preferences are not available, so the candidate 

cannot re-enable the tools. 

 

 

Security for candidates who do have permission to use Spellcheck: SQA policy requires that 

candidates do not have access to dictionary tools, ie Define or Explore, so it is necessary to disable 

these. However, internet access is required for candidates who have permission to use Spellcheck 

or Voice Typing; we do not know if it is possible to enable Spell Check and/or Voice Typing but 

disable Define or Explore.  

Saving and printing: If the devices were offline, centres would have to develop procedures to 

make blank DABs available on the Chromebook, and to print the completed booklets.  

 

Table 1: Google Docs literacy tools offline functionality 

Figure 20: Google Docs Preferences 
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Microsoft Word app  

An Android app version of Microsoft Word (Microsoft, 2019a) is now available from the Google Play 

Store, and this functions on Chromebooks that can run Android apps24.   

The Word app works both on and offline. It has a built-in spellchecker and grammar checker that 

can be switched off in the software Settings, but we did not find a way to disable it completely to 

prevent a candidate from re-enabling it. There is a Smart LookUp tool that can be disabled by 

disconnecting the device from the internet or preventing access to the Microsoft server. In our tests, 

the Chrome Select and Speak tool did not operate, nor did third-party Chrome apps — presumably 

because Word is an Android app rather than Chrome software.  

 

 

Microsoft Word Online 

Word Online (Microsoft, 2019b) is the online version of Microsoft Word and is available to Scottish 

schools through Glow. The SQA DABs in doc format do not open correctly in Word Online, but it 

might be used as a straightforward word processor in an examination — provided that wider internet 

access can be restricted, given that it runs online. Files are opened from OneDrive and can be 

downloaded to the Chromebook. Changes are saved automatically.  

Word Online has Immersive Reader25, which simplifies layout, gives control over font and colours, 

and a built-in text reader. Outside Immersive Reader, Chrome Select and Speak does not work, but 

Read&Write does. Word Online Spellcheck is part of the software, like Google Docs, and so it 

remains available when the Chrome spellcheck is disabled on the device. Spellcheck can be turned 

off in Word Online settings but candidates can easily turn it back on. We do not know if it possible to 

disabled it permanently.  

 

24 Chrome OS Systems Supporting Android Apps https://sites.google.com/a/chromium.org/dev/chromium-

os/chrome-os-systems-supporting-android-apps 

25 Microsoft Learning Tools https://www.microsoft.com/en-us/education/products/learning-tools 

Figure 21: Android Word app with a DAB 

https://sites.google.com/a/chromium.org/dev/chromium-os/chrome-os-systems-supporting-android-apps
https://sites.google.com/a/chromium.org/dev/chromium-os/chrome-os-systems-supporting-android-apps
https://www.microsoft.com/en-us/education/products/learning-tools
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Google Office File Editor 

The Google Office File Editor26 (Google, 2019b) can open Word files (and other formats). Once the 

file has been saved to the Chromebook, changes are saved automatically. Some accessibility 

extensions functioned with it in our tests, although not Read&Write. The editor uses the built-in 

Chrome Spellcheck which can be turned off in Chrome Settings, but not permanently. 

Google Forms 

Google Forms27 (Google, 2018b) is designed for surveys and quizzes, and teachers are also using it 

for assessments. It would be possible to create a Form template with a list of blank questions for 

candidates to type in answers. Most of the accessibility tools function in Google Forms and 

TextHelp’s Equatio equation editor can also be used to generate mathematical expressions. It uses 

the Chrome Spellcheck, which can be disabled in Chrome Settings, but again the candidate could 

enable it and we have not found a way to successfully disable it with the Admin Console. 

 

 

 

 

DocsPlus 

DocsPlus28 (Crick Software, 2019) is a word processor with literacy support tools — wordbars (word 

banks), word prediction, spellcheck and text reader — aimed at secondary schools. It is described in 

more detail in the later section on DocsPlus. It has an Exam Mode whereby the support tools can be 

disabled and it operates offline, so it may provide a practical solution for schools in that it offers 

security, accessibility and ease of administration. DocsPlus costs £30 for a single-user annual 

subscription, and £500 for a school subscription. 

 

26 Google Office Editor https://chrome.google.com/webstore/detail/office-editing-for-docs-

s/gbkeegbaiigmenfmjfclcdgdpimamgkj?hl=en  

27 Google Forms https://www.google.co.uk/forms/about/  

28 DocsPlus for Chromebook https://www.cricksoft.com/uk/docsplus/chromebook 

 

Figure 22: An example of a DAB created with Google Forms 

https://chrome.google.com/webstore/detail/office-editing-for-docs-s/gbkeegbaiigmenfmjfclcdgdpimamgkj?hl=en
https://www.google.co.uk/forms/about/
https://www.texthelp.com/en-gb/products/equatio/equatio-for-google/
https://chrome.google.com/webstore/detail/office-editing-for-docs-s/gbkeegbaiigmenfmjfclcdgdpimamgkj?hl=en
https://chrome.google.com/webstore/detail/office-editing-for-docs-s/gbkeegbaiigmenfmjfclcdgdpimamgkj?hl=en
https://www.google.co.uk/forms/about/
https://www.cricksoft.com/uk/docsplus/chromebook
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Disabling Chrome Spellcheck and writing supports 

A key requirement for using technology in examinations is to prevent access to the Spellcheck 

facility and other writing tools by candidates who do not have permission to use them. Writing tools 

are available in the Google Office File Editor, Google Forms, and other tools are: 

 Spell check 

 AutoCorrect 

 Word prediction 

 Auto-capitalisation 

 Voice Typing / Dictation 

These features are part of the Chrome operating system and can be turned off in the Chromebook 

Settings. However, there is nothing to prevent a candidate from switching them back on, so it is 

necessary for them to be disabled completely in an examination. Google state that the Spellcheck 

can be disabled for accounts with the Google Admin Console29 but in our tests, the Spellcheck was 

still operational even after it was disabled. 

Commercial assessment platforms 

There are several commercial assessment and examination systems that are designed specifically 

for administering assessments and examinations. They have facilities to, for example, restrict 

access to the internet or to support tools such as Spellcheck. Testing all the available systems was 

not within the scope of this project and we summarise key aspects of some of the products here, 

with regard to using them for candidates who wish to use ICT as an Assessment Arrangement: 

 ChromeEx30 is ‘for creating, administering and assessing digital exams in schools’. We do not 

think it is suitable for use by candidates who require Assessment Arrangements because it does 

not provide accessibility tools, and the fact that it runs in as a single Kiosk app will prevent use 

of accessibility tools that candidates may require, such as a text reader.  

 DigiExam31 is an online assessment platform for PC, Mac, Chromebook and iPad. It has 

accessibility features such as Spellcheck and text reader built in.  

 

29 Set Chrome user policies https://support.google.com/chrome/a/answer/2657289?hl=en  

30 ChromeEx Digital exams for G Suite for Education https://www.chromex.io/en 

31 DigiExam https://www.digiexam.com/ 

Figure 23: DocsPlus word prediction 

https://support.google.com/chrome/a/answer/2657289?hl=en
https://www.chromex.io/en
https://www.digiexam.com/
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 SurpassPaper+32 is a secure word processing app designed specifically for examinations, and 

was piloted by SQA in 201633. SurpassPaper+ does not function on Chromebooks, only 

Windows and iPad. 

 WISEflow34 is another online assessment platform but again the secure browser that provides 

security does not operate on Chromebooks.  

Refer to the later section on Technical administration of Chromebooks in SQA examinations for a 

more detailed discussion of these tools. 

  

 

32 SurpassPaper+ https://www.btl.com/surpass/paperplus/ 

33 SQA renews e-Assessment contract with BTL Group, https://www.sqa.org.uk/sqa/90399.html 

34 WISEflow — the digital exam platform https://uniwise.dk/digital-exam-platform/) 

https://www.btl.com/surpass/paperplus/
https://www.sqa.org.uk/sqa/90399.html
https://uniwise.dk/digital-exam-platform/
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Summary of Chromebook tools for use of ICT to write answers 

The table below summarises the relevant features for each of the Chromebook tools discussed in 

this section. ChromeEx is not included as it does not have the required accessibility tools. 

 Google Docs Microsoft 
Word online 

Microsoft 
Word 
Android 
app 

Google 
Office File 
Editor 

Google 
Forms 

DocsPlus DigiExam 

Cost Free Free  Free  Free  Free  Annual: £30 
single user; 
£500 school  

Contact 
DigiExam 

Access 
.docx DABs 

No No Yes No No No No 

AutoSave Yes Yes Yes Yes Yes Yes Yes 

Change 
colours 

Yes 

 

Yes — in 
Immersive 
Reader  

No 

 

No  No  Yes  Not 
known 

Text reader Select and 
Speak 

Yes — in 
Immersive 
Reader 

No Select and 
Speak 

Select and 
Speak 

DocsPlus & 
Select and 
Speak 

DigiExam 

Spellcheck Yes Yes Yes Yes 
(Chrome) 

Yes 
(Chrome) 

Yes Yes 

Disable 
Spellcheck 

Yes -
disconnect 
internet. 

Disable in 
Settings, but 
not 
permanent 

Disable in 
Settings, 
but not 
permanent  

Disable in 
Chrome 
settings 
(not 
permanent) 

Disable in 
Chrome 
settings (not 
permanent) 

Yes — 
Exam Mode 

Yes  

Other 
Literacy 
Support 

AutoCorrect, 
prediction, 
Define, 
Explore. 

Immersive 
Reader, 
AutoCorrect, 
Grammar, 
Translate  

Grammar, 
Translate 

No No  Word 
banks, 
prediction 

Not 
known 

Disable 
other 
literacy 
supports 

Not known if 
Define/Explore 
can be 
disabled when 
Spellcheck is 
enabled. 

No Disable 
Grammar in 
Settings. 
Disconnect 
internet. 

N/A N/A Yes — 
Exam Mode 

N/A 

Computer 
dictation 

Yes — Google 
Dictation 

Yes — MS 
Dictate & 
Google 
Dictation 

Yes — 
Google 
Dictation 

Yes — 
Google 
Dictation 

Yes — 
Google 
Dictation 

Yes — 
Google 
Dictation 

Not 
known 

Drawing & 
annotations 

Yes Yes  Yes yes No  No   Yes  

Maths & 
science 

Yes Yes  Yes 

 

No  No  No   Yes  

Offline use Yes No Yes Yes  No  Yes Yes 

 

Table 2: Summary of Chromebook word processors and text editors 
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None of the tools reviewed offer all the desired features in terms of accessibility, literacy support, 

drawing and maths, and examination security, and so centres may choose one or more that best 

meets the needs of the students. 

Candidates who do not have permission to use Spellcheck 

Candidates who do not have permission to use Spellcheck or other supports could use Google 

Docs to type up examinations by disconnecting the Chromebook from the internet: this disables the 

spelling and literacy tools.  

Google Editor and Forms may be suitable for candidates, but the built-in Chrome Spellcheck cannot 

(as far as we know) be disabled completely. Centres will therefore have to disable the Spellcheck 

and other literacy tools in the device Settings and adopt invigilation procedures to ensure that 

candidates do not turn them back on.  

DocsPlus is option, offering literacy and accessibility tools that can be disabled in Exam Mode, but it 

does not offer drawing tools or an equation editor. 

Of the commercial assessment systems, DigiExam may offer a solution as it provides both security, 

accessibility, drawing and an equation editor.  

Candidates who do have permission to use Spellcheck  

Candidates who have permission to use Spellcheck and other writing supports could use Google 

Forms and Google Editor. 

Google Docs is not suitable for candidates who use Spellcheck because the Google Docs 

Spellcheck requires internet access, which then also allows access to the Define and Explore 

features that are not permitted. We do not know if these tools can be disabled while leaving 

Spellcheck and Automatic Substitution enabled.  

DocsPlus provides many of the desirable tools and security options, while DigiExam provides 

security, accessibility, drawing and an equation editor.  
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Digital question papers 

Background 

Digital question papers are digital versions of the question paper. They are provided by SQA for 

candidates who have difficulty accessing, reading or interacting with the standard hard copy papers 

(Scottish Qualifications Authority, 2017a). 

Digital question papers (DQPs) were first offered as an Assessment Arrangement by SQA in 2008, 

following development, evaluation and pilot projects undertaken by CALL and SQA (Nisbet, Aitken 

and Shearer, 2004; Nisbet et al., 2006; Nisbet, 2007, 2009). The DQPs were PDF files. PDF was 

chosen because: 

 The trials and pilots had shown that the PDF DQPs were accessible for the majority (but not all) 

of candidates who require assessment arrangements. 

 The digital papers could be made interactive, so that candidates can type and draw answers on 

screen. The research indicated that this was an important feature for candidates. 

 PDF was a cross-platform and proven reliable file format. 

 Adobe Reader software for accessing PDFs was installed as standard on all school computers. 

 Staff and learners were therefore generally familiar with the software. 

 Internet provision in schools was in 2008 inadequate to support reliable online delivery of 

examinations, and PDF was a suitable format for delivery on CD. 

 Production costs to SQA were very low, as PDFs of papers were produced already as part of the 

existing production process. 

DQPs were developed to complement the existing Assessment Arrangements including, for 

example, papers in large print or braille; use of human readers or scribes; use of a word processor; 

etc. The PDF DQPs are not suitable for every candidate and every subject: for example, the 

standard SQA DQPs are not optimised for candidates with significant visual impairment who use 

screen reading technology. In addition, because the examinations are designed to be accessed on 

paper, some questions do not particularly suit the digital medium: mathematical and scientific 

formulae cannot be read out by a computer reader, while options for candidates to generate 

mathematical formulae using technology do exist, but are very limited with the DQP PDF files. 

Digital question papers are produced by SQA in two styles: 

 ‘Question-and-answer’ digital question papers with ‘answer boxes’ for candidates to type 

answers on-screen. These papers are digital versions of the paper booklets which have space 

provided for candidates to handwrite answers on the paper.  

 ‘Question-only’ papers that do not have answer boxes. Candidates can use this type of DQP to 

read the questions. To record answers, a candidate uses a word processor and/or a digital 

answer booklet (DAB). DABs are digital versions of the paper answer booklets. DABs are 

provided by SQA in PDF and Word format. 
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Digital past papers for the past five years can be downloaded from SQA’s website 

www.sqa.org.uk/digitalquestionpapers for revision and practice.  

Accessibility features of SQA digital question papers on Windows OS 

SQA DQPs that are accessed using a standard Windows computer using the free Adobe Reader 

software have a number of helpful accessibility features (Scottish Qualifications Authority, 2016a). 

These features have proven to be beneficial for candidates over the 10 years since DQPs were 

introduced, and similar functionalities are therefore required when using Chromebooks or other 

devices. Before we turn to how Chromebooks can be used to access DQPs, we summarise the 

current technology available on Windows. These features form a specification for testing 

Chromebooks and Chromebook apps and extensions for accessing digital question papers.  

Opening and saving DQPs and DABs 

SQA currently delivers DQPs on CD as PDF files. Centres then distribute the files to candidates 

either via secure network, or install from the CD, or via a USB stick. On Windows, candidates 

typically double click to open the DQP in Adobe Reader. The paper can be saved to any file 

location. Adobe Reader has an auto-save feature to save candidates’ answers. 

Zoom / magnify 

Candidates with a visual impairment can zoom in to magnify the questions. Question-only papers 

can be ‘re-flowed’ to fit the screen area. Two pages can be viewed side-by-side. 

Colours 

Background and foreground colours can be set for candidates who need a high contrast, or for 

students with visual stress who may require a specific background colour (Wilkins et al., 2001; Kriss 

and Evans, 2005; Rello and Bigham, 2017). 

Figure 26: Digital Question paper 

with answer boxes 

Figure 24: Digital Question paper 

without answer boxes 

Figure 25: Digital answer booklet 

http://www.sqa.org.uk/digitalquestionpapers
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Text readers 

Text to speech is one of the most useful and empowering accessibility tools. Text to speech 

enhances student choice, differentiation and self-advocacy (Parr, 2011), can improve reading 

comprehension (Lange et al, 2006; Floyd and Judge, 2012; Park et al, 2017; Wood et al., 2017) and 

proficiency (Park et al, 2017) for learners with reading difficulties.  

SQA creates digital papers so that any text that is necessary for the candidate to answer the 

question can be selected and read out using a computer text reader. Computer text readers for 

Windows computers are available at zero cost to schools, or in the form of commercial Literacy 

Support software (see CALL Scotland’s Text to Speech web pages35). On Windows and MacOS, 

candidates have the option of reading with two high quality Scottish accent computer voices, and a 

Scottish Gaelic computer voice, which can be downloaded and installed on Windows school 

computers free of charge from CALL Scotland’s Scottish Voice website36. The combination of free 

text reader and computer voices provides centres with high quality accessibility provision at zero 

purchase cost. 

Screen readers 

Screen readers such as Jaws or NVDA on Windows, VoiceOver for MacOS and iOS, and 

ChromeVox for Chromebooks, are designed for people who cannot see, and who require everything 

on the device to be read out. Screen readers provide information about what is on screen, where it 

is, and what it is. Current DQPs produced by SQA are not optimised for candidates who use screen 

readers (Nisbet and Aitken, 2017).  

 

35 Text-to-speech, http://www.callscotland.org.uk/information/text-to-speech/  

36 Scottish Computer Voices http://www.thescottishvoice.org.uk/home/  

Figure 27: Zoom and reflow to fit the screen; configure background colour 

http://www.callscotland.org.uk/information/text-to-speech/
http://www.thescottishvoice.org.uk/home/
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Navigation 

SQA designers add ‘bookmarks’ to DQPs so that candidates can quickly navigate around the paper. 

Candidates can also navigate using page thumbnails. Candidates can move between pages with 

keyboard, mouse or scrollbar or touch screen. 

Answer boxes and interaction 

An important aspect of the ‘question-and-answer’ DQPs is the facility to type or dictate answers into 

an answer box in the question paper and draw and annotate on screen. Drawing on-screen is not 

used by many candidates, according to the responses to annual SQA surveys — most candidates 

use the paper copy and draw by hand — but it is an important option for students with physical 

support needs who cannot hold or manipulate manual pens or drawing implements. 

 

 

 

 

Physical support needs 

Candidates who cannot use a physical keyboard can type with an on on-screen keyboard using a 

mouse, joystick, switches or eye gaze camera. Candidates can use the free on-screen keyboard 

provided in Windows or a third-party package with specific features.  

Figure 28: DQP showing coloured background, computer text reader, navigation bookmarks, and answer boxes 

Figure 29: Using the drawing tools to complete a question 
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For example, Tobii eye gaze cameras would be used with the Tobii Windows Control software37 and 

keyboard; while a candidate who uses a switch, eye gaze or pointing device might use Grid 338 to 

access the papers and generate responses. Tools like Grid 3 offer more efficient computer control, 

the option to create on-screen keyboards optimised for the user and the subject, and speech output 

for communication.  

Candidates who cannot use a mouse or other pointing device can navigate the paper and type 

answers using keyboard shortcuts.  

Spellcheckers and literacy support tools 

SQA’s policy is that spellcheckers cannot be used in examinations unless the candidate has an 

identified spelling difficulty which places them at a substantial disadvantage for the particular 

examination and a request to use spellcheck has been made and permission received using the 

SQA AAR online system (Scottish Qualifications Authority, 2016b).  

To support centres to manage access to spellcheckers in the examination, SQA provides two 

versions of each DQP: one paper that is ‘spellcheck enabled’, where the Adobe Reader 

spellchecker will function, and a second paper where the spellchecker is not enabled. Centres 

provide the spellcheck-enabled papers to candidates who have permission to use the spellchecker, 

and the spellcheck-disabled papers to candidates who do not have permission to use a 

spellchecker. 

 

 

37 Tobii Windows Control. https://www.tobiidynavox.com/en-gb/software/windows-software/windows-control-

software/  

38 SmartBox Grid 3 https://thinksmartbox.com/product/grid-3/  

Figure 30: The Windows on-screen keyboard enables candidates with physical support needs to access the papers 

https://www.tobiidynavox.com/en-gb/software/windows-software/windows-control-software/
https://www.tobiidynavox.com/en-gb/software/windows-software/windows-control-software/
https://thinksmartbox.com/product/grid-3/


36 

 

 

Other writing supports, such as dictation, AutoCorrect and word prediction are becoming available 

as standard on devices and word processors, including Chromebooks, and so centres will require a 

means to disable access to these tools when using interactive digital question papers.  

Mathematics and science 

The answer boxes in SQA maths and science DQPs are RTF (rich text formatted) fields, which 

allow the use of bold, italics, underlines and super/sub scripts in Adobe Reader for Windows.  

Simple mathematical expressions can be typed into the DQP, but more complex algebraic 

equations cannot be realistically entered, while drawing graphs and charts is not practical with the 

basic Adobe Reader drawing tools. For Windows OS, CALL Scotland therefore recommends (CALL 

Scotland, 2015) use of a specialist equation editor and/or drawing program such as FX Draw39. 

 

Figure 32: Simple expressions can be typed with Adobe 

Reader 

 

Figure 33: More complex expressions and symbols require 

an equation editor such as FX Equation, which works best 

with Microsoft Word rather than the PDF DQP 

 

 

39 FX Draw https://www.efofex.com/fxdraw.php  

Figure 31: The Adobe Reader spellchecker 

https://www.efofex.com/fxdraw.php
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Similarly, while simple diagrams can be created with the Adobe Reader annotation tools, more 

complex diagrams such as graphs, pie charts, sketches, circuit diagrams and technical drawings will 

typically require more specialist maths, drawing or CAD software.  

Accessing DQPs and PDF DABs with Chromebooks 

There are many Chromebook apps and extensions available that can open and access PDFs and it 

was impossible to research every one. Instead, we reviewed and then tested the most promising 

apps/extensions following internet research and discussions with colleagues in local authorities and 

Google. The results of tests with Chrome PDF Viewer, DocsPlus, Kami, Snap&Read, Texthelp PDF 

Reader and Xodo are given in this report. 

We anticipate that this information will be updated as the apps and extensions are developed, and 

as new products appear on the market.  
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Question-only digital question papers 

As noted previously, around half of the SQA digital papers are ‘Question-only’ where a candidate 

may read the paper on screen and type answers using a separate digital answer booklet or word 

processor. All of the apps and extensions reviewed here can be used to access a question-only 

DQP. Relevant factors and considerations for PDF readers for DQPs are: 

 Ability to view DQP and answers side by side. 

 View and zoom options. 

 Colour adjustment or overlays. 

 Text reader functionality. 

 Keyboard only and mouse-only access. 

 Offline use (so that the device can be disconnected from the internet for security). 

Tools for accessing question-only DQPs 

 Chrome 
PDF Viewer 

DocsPlus Kami for 
Schools 

Snap&Read 
universal 

Texthelp PDF 
Reader 

Xodo 

View DQP 
and DAB 
side by 
side 

Yes No  Yes  Yes  Yes  Yes 

Zoom / 
magnify 

Yes Yes  Yes  Yes  Yes Yes 

Change 
colours 

No No  No Yes — but the 
colour overlay 
did not work in 
our tests; the line 
ruler did. 

No  No 

Read with 
computer 
text reader 

Yes, 
Chrome 
Select and 
Speak. 

Yes — use 
the DocsPlus 
reader or 
Select and 
Speak. 

Yes  Yes  Yes — a text 
reader is built in. 
There is also a 
ScreenShot 
Reader. 

No 

Scottish 
computer 
voices 

Yes, by 
buying 
Acapela’s 
Rhona voice 

Yes, by 
buying 
Acapela’s 
Rhona voice 
and using 
Select and 
Speak. 

Yes, by 
buying 
Acapela’s 
Rhona 
voice. 

Yes, by buying 
Acapela’s Rhona 
voice. 

Yes — Fiona 
(Vocaliser) is 
available in 
Read&Write, and 
Acapela’s Rhona 
voice will also 
work if it has 
been purchased 
and installed. 

No 

Keyboard 
only 
access 

Good  Limited  Good  

 

Limited  

 

Limited  Good 

Offline use Yes Yes Yes  No  No  Yes  

 

Of the apps reviewed, centres might consider: 

 Chrome PDF Viewer 

 Kami for Schools 

 Texthelp PDF Reader 

Table 3: Chromebook tools for question-only DQPs 

https://www.callscotland.org.uk/blog/new-voices-for-your-chromebook/
https://www.callscotland.org.uk/blog/new-voices-for-your-chromebook/
https://www.callscotland.org.uk/blog/new-voices-for-your-chromebook/
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as they enable the DQP to be viewed alongside the candidate’s answers, and a text reader can be 

used to read the questions. 

Viewing DQP and answers side by side 

Accessing a DQP with a separate word processor for answers requires the candidate to use two 

windows, apps or extensions and arrange them on screen side by side on screen or swap between 

the windows. 

Figure 34 illustrates the use of TextHelp PDF Reader to read the questions with text-to-speech, 

together with Google Docs to type the answers. 

 

 

To arrange the two windows on screen, drag one tab to a separate location, click and hold on the 

Maximise button until you see the two horizontal arrows, then choose either the left or right arrow to 

dock the window. Drag and re-size the windows manually if you want to see them on top and bottom 

of the screen.  

 

Figure 34: Reading a DQP with Texthelp PDF Reader and typing answers with Google Docs 

Figure 35: DQP and DAB in PDF accessed with Xodo 
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Question-and-answer digital question papers 

Question-and-answer DQPs have answer boxes where candidates can type or dictate text and can 

also use drawing and annotation tools to interact with the assessment. 

Of the PDF readers tested, Chrome PDF Viewer, DocsPlus, Kami and Xodo can be used to type 

answers into the on-screen fields.  

 

 

 

Snap&Read and Texthelp PDF Reader cannot type text into the answer boxes, although it is 

possible to insert a text comment ‘on top’ of the PDF. 

Relevant features and considerations for accessing Question-and-answer PDFs are: 

 Autosave 

 Printing 

 Access to answer boxes 

 Text reader functionality 

 Spellcheck and literacy support tools — whether they are provided, and if they can be disabled 

for candidates for whom literacy support is not permitted 

  

Figure 36: Typing into answer boxes with Chrome PDF Viewer 
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Tools for accessing question-and-answer DQPs 

 Chrome 
PDF 
Viewer 

DocsPlus Kami for 
Schools 

Snap&Read 
universal 

Texthelp PDF 
Reader 

Xodo 

Cost Free Annual 
subscription: 
£30 single user; 
£500 school 
licence 

Contact Kami. $3.99/month for 
a personal 
licence (credit 
card only)  

Annual subscription: 
£150 single user; 
from £800 school. 

Free  

Autosave DQP No Yes  Yes No  No No 

Printing Yes  No, for a DQP Yes  Yes  Yes  Yes  

Type into 
answer boxes 

Yes  Yes  Yes  

 

No. 

Use the Text 
tool to type ‘on 
top’ of the 
answer box. 

No. 

Use the Typewriter to 
type on top. 

Yes 

Read with 
computer text 
reader 

Yes, 
Chrome 
Select 
and 
Speak. 

Yes — use the 
DocsPlus reader 
or Select and 
Speak. 

Yes  Yes  Yes — a text reader 
is built in. There is 
also a ScreenShot 
Reader. 

No 

Spellchecker No. Yes (DocsPlus) Yes (Chrome 
Spellcheck) 

Yes (Chrome 
Spellcheck) 

Yes (Chrome 
Spellcheck) 

No 

Literacy 
supports 

No. Word prediction, 
word banks. 

 

Dictionary / 
Lookup 
(internet 
required) 

Highlight and 
collect text from 
the paper to an 
outline. 

Define, Simplify 
Text, Translate 
tools. 

Word prediction, 
Picture Dictionary, 
Online Dictionary, 
highlighter to collect 
notes and quotes, 
translator 

No 

Exam Mode / 
disable 
Spellcheck and 
writing supports 

N/A Yes  No  no No  N/A  

Offline use Yes Yes Yes  No  No  Yes  

 

Only DocsPlus and Kami provide an Autosave function, which we think is essential for 

examinations. However, DocsPlus appears to limit the amount of text that can be typed into an 

answer box, while the user experience with Kami’s answer boxes is not satisfactory and we could 

not find a mechanism for disabling the Spellcheck securely. 

Therefore, we do not recommend any of these tools for accessing question-and-answer digital 

papers.   

  

Table 4: Chromebook tools for Question-and-answer DQPs 
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Chrome PDF Viewer 

Summary 

SQA DQPs can be opened and viewed using the Chrome Online Viewer when PDFs are opened in 

the browser, and a separate Offline PDF Viewer which can be used for files downloaded to the 

Chromebook.  

The PDF Viewers may be suitable for question-only DQPs: the DQPs can be magnified and 

zoomed, and the Select and Speak can read the questions. While answers can be typed into 

Question-and-answer DQPs and saved, the lack of Autosave or Spellcheck means it is not suitable 

for examinations. 

Pricing 

Free, built into Chromebooks. 

Question-only digital question papers 

When a DQP is opened on a Chromebook from Google Drive it is initially displayed using the Online 

browser-based PDF Viewer. This can be used to view the DQP and the PDF can be zoomed to 

enlarge the text, so it may be suitable for candidates who need a basic PDF viewer to access a 

digital paper. By downloading the DQP to the device itself, it can be opened with the PDF Viewer. 

Select and Speak can be used to read the text and candidates can navigate the paper with the 

bookmarks. 

 

Question-and-answer digital question papers 

Answers can be typed into boxes and the file can be saved. However, there is no AutoSave, which 

we think is essential for use in examinations. There does not seem to be a Spellcheck, so the PDF 

Viewer may be suitable for candidates who do not have permission to use Spellcheck, but it is not 

suitable for those who require it.  

Figure 37: Reading with Chrome Select and Speak 
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Examination arrangements 

There are no settings for administering examinations. PDF Viewer can run without an internet 

connection so that is one measure that could be used to address security concerns.  

  

Figure 38: Answers can be typed in and saved. There is no Spellcheck. 
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DocsPlus  

Summary 

DocsPlus (Crick Software, 2019) is a literacy support app designed for secondary schools. It is 

available on Windows, Mac and Chromebooks. DocsPlus provides a Document window for typing 

answers, and a DocReader window that can read and access DQPs. It has good tools to support 

reading and writing and they can be disabled if not required using an Exam Mode. The literacy tools 

are:  

 wordbars (word banks) 

 word prediction 

 Spellcheck 

 text reader 

 

 

DocsPlus is a good solution for candidates who wish to use technology for typing answers, and the 

Exam Mode eases administration. Question-only DQPs can be viewed and read with text-to-speech 

but inability to view question paper and answers side by side may be problematic for some 

candidates. We do not recommend it for question-and-answer DQPs because the paper cannot be 

printed directly from the app. 

Pricing 

DocsPlus for Chromebook costs £30 for a single user one-year subscription, and £500 for a one-

year site license. 

Question-only digital question papers 

Candidates can access DQPs with the DocReader and use the text reader to read the questions. 

Limitations are that colours cannot be adjusted, and the choice of voices is limited and does not 

include Scottish accents. Users cannot view both a DQP and their answers in a document at the 

same time. 

Figure 39: DocsPlus word prediction 

https://www.cricksoft.com/uk/docsplus/chromebook
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Question-and-answer digital question papers 

Candidates can type answers into answer boxes in the DQP, and the literacy tools work well. 

However, the font for the answer boxes seems large and the amount of text that can be typed is 

therefore relatively small. In our tests there seemed to be a limit on the amount of text — between 

250 and 450 characters — that could be typed into PDF DABs. Beyond this the text cursor was not 

in the correct location and editing was virtually impossible. The paper cannot be printed directly from 

within the app, and we found that answers were not formatted correctly when opened in other PDF 

readers in order to print.  

 

 

Examination arrangements 

DocsPlus has an Exam Mode which is easy to use and allows all the support tools to be switched 

off individually. It does not require internet to function. 

More Information 

 DocsPlus app for Chromebook  

 Using DocsPlus in exams 

 Reviews and success stories 

Figure 40: DocsPlus text reader 

Figure 41: Typing into an answer box with DocsPlus 

https://www.cricksoft.com/uk/docsplus/chromebook
https://www.cricksoft.com/uk/docsplus/chromebook/learn-more/using-docsplus-in-exams
https://www.cricksoft.com/uk/docsplus/chromebook/success-stories
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Kami for Schools 

Summary 

Kami (Kami, 2019) is a Chrome app and extension for reading and annotating PDF files. It is 

available in Basic and Premium for Schools versions. Basic is not suitable for use in examinations 

because it does not have text-to-speech, does not Autosave answers and has adverts. The 

Premium (subscription) Kami has good features for reading question-only DQPs and some helpful 

facilities for accessing question-and-answer DQPs (eg AutoSave) but the user experience with 

answer boxes is not the best.  

Pricing 

Basic is free and lets you open and read the DQP and/or DAB in PDF format. The Premium 

Teacher Plan is $99 per teacher/class per year and there are licencing arrangements for Kami for 

Schools.  

Question-only digital question papers 

DQPs can be opened, viewed and read with the built-in text reader. There is zoom but colours 

cannot be adjusted. 

 

 

Question-and-answer digital question papers 

Candidates can type into answer boxes, although they are transparent so any handwriting guides 

are visible which may be distracting, particularly when Kami is used to access a Digital Answer 

Book in PDF.  

There are a good range of drawing and annotation tools and an equation editor. The Chrome 

Spellcheck functions in both ‘spellcheck on’ and ‘off’ DQP and PDF DABs. 

Figure 42: Reading with Kami Text to Speech 

https://www.kamiapp.com/
https://www.kamiapp.com/pricing/
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Examination arrangements 

There is no exam mode. Kami can work offline, which may make administration easier to organise. 

The built in Chrome Spellcheck can be disabled in the Chrome Settings, but not permanently.  

More Information 

 Kami 

 Kami pricing  

  

Figure 43: Answers can be typed into answer boxes 

https://www.kamiapp.com/
https://www.kamiapp.com/pricing/
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Snap&Read  

Summary 

Snap&Read (Don Johnston, 2019) is an extension designed for improving access to websites and 

documents and it can also view and annotate PDFs. Candidates who wish to read question-only 

DQPs may find it helpful: it has a good text reader, a Screenshot reader, and other reading and 

study tools. Answers cannot be typed into answer boxes and there is no Autosave, so we do not 

recommend it for Question-and-answer DQPs.  

We have been informed by Don Johnston, the US suppliers, that as of May 2018 school or 

organisational licences are no longer sold in the UK or the European Union as a result of difficulties 

with GDPR compliance. It is still available in the Google Play store. 

Pricing 

$3.99/month for a personal licence (credit card only). 

Question-only digital question papers 

Snap&Read has good tools for reading and accessing DQPs, though some of the supports (eg 

Define) are not permitted in an examination.  

 

 

Question-and-answer digital question papers 

Users cannot type into answer boxes, but candidates can click and type answers ‘on top’ of the 

PDF. However, there is no AutoSave and each time the DQP is saved, a new file is created, which 

is likely to be confusing for candidates. 

Figure 44: Snap&Read text reader 

https://learningtools.donjohnston.com/product/snap-read/
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Examination arrangements 

We think that Snap&Read can be configured to enable or disable access to different support tools 

but have not been able to confirm this. In our tests Snap&Read did not function unless it was 

connected to the internet.  

More Information 

 Snap&Read https://learningtools.donjohnston.com/product/snap-read/ 

 

  

https://learningtools.donjohnston.com/product/snap-read/
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Texthelp PDF Reader 

Summary 

PDF Reader (Texthelp, 2019) is part of Texthelp’s Read&Write for Google Chrome extension. 

Read&Write is a long-established literacy support package with versions available for Windows, 

Mac, Android and iPad as well as Chrome.  

The free version of PDF Reader can view a DQP and read the questions with text-to-speech, so 

PDF Reader is a good option for accessing question-only DQPs. Typing and interacting with DQPs 

requires the Premium version, but the lack of Autosave and the inability to type into answer boxes 

means that we do not recommend it for question-and-answer DQPs.  

Pricing 

Premium costs £150 for an annual subscription for a single user and from £800 for an annual 

subscription for a school. Local authority site licences are also available. Teachers can get free 

access to the Premium version. 

Question-only digital question papers 

Candidates can access question-only DQPs using both free and premium versions of TextHelp PDF 

Reader. PDF Reader provides zoom and colour screen masking tools. The ‘Click to Speak’ text 

reader works well, and there is also a ‘Screenshot Reader’ (Premium only) where the candidate can 

draw an area around the text to be read. There are dictionary and picture dictionary and highlighting 

tools for marking and collating quotes and references from the DQP.  

 

 

Question-and-answer digital question papers 

Candidates cannot type into answer boxes, but the ‘Typewriter’ tool can be used to type ‘on top’ of 

the PDF. This requires the candidate to draw answer boxes manually using the mouse or trackpad, 

which some candidates will find difficult or impossible. It is also possible that candidates could type 

answers outside the area of the file that will be scanned by the e-Marking system, and therefore 

Figure 45: Reading with text to speech 

https://www.texthelp.com/en-gb/company/education-blog/april-2019/transform-pdfs-with-the-texthelp-pdf-reader/
https://www.texthelp.com/en-gb/products/read-write/read-write-for-google/
https://www.texthelp.com/en-gb/pricing/
https://www.texthelp.com/en-gb/products/free-for-teachers/
https://www.texthelp.com/en-gb/products/free-for-teachers/
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lose marks. A new copy of the DQP is saved every time the Save button is clicked, so candidates 

will generate multiple files, which may be confusing. 

 

 

The typewriter in PDF Reader has helpful tools for supporting writing, including spellchecker, word 

prediction and voice typing. They cannot be turned off and so PDF Reader is not suitable for 

candidates for whom literacy support is not permitted.  

TextHelp’s Equatio equation editor can be used to write equations and mathematic expressions into 

DQPs: a premium subscription is required. There are no drawing tools provided. 

Examination arrangements 

PDF Reader does not have an exam mode. The writing supports in the Typewriter cannot be turned 

off and so PDF Reader is not suitable for candidates for whom literacy support is not permitted. In 

our tests Snap&Read did not function unless it was connected to the internet.  

However, Texthelp also offers Read&Write for Assessments40. This appears to be a simple text 

editor where accessibility features such as Spellcheck, text-to-speech and word prediction can be 

enabled as required. Texthelp suggests that it should be applied in Kiosk Mode, which allows only 

one app to run. They suggest that one Chromebook is provided to read the DQP and a second to 

write responses: ‘for students that require IEP accommodations for writing, they’ll need a secondary 

device with a secure writing environment that includes necessary accommodations like text-to-

speech, word prediction and Talk&Type’. 

More Information 

 PDF Reader 

 Read&Write for Google Chrome 

 Pricing  

 Make your PDFs accessible and collaborative Webinar 

 Transform PDFs with the Texthelp PDF Reader 

 Why Stop with G Suite and Microsoft Word? Type Math in PDFs Too! 

 

40 Read&Write in Assessments, https://www.texthelp.com/en-us/sectors/education/exams-and-assessment/ 

Figure 46: Type or dictate ‘on top’ of the DQP 

https://support.texthelp.com/help/equatio-pdf-integration
https://support.texthelp.com/help/texthelp-pdf-reader
https://www.texthelp.com/en-gb/products/read-write/read-write-for-google/
https://www.texthelp.com/en-gb/pricing/
https://mautic.texthelp.com/k-12-webinar-series-pdf-resources
https://www.texthelp.com/en-gb/company/education-blog/april-2019/transform-pdfs-with-the-texthelp-pdf-reader/
https://www.texthelp.com/en-us/company/education-blog/july-2018/type-math-in-pdfs/?utm_campaign=K-12:-Demand-Gen-Schools|NA-Edu-K12-PDF-Reader-webinar-recording-Apr-2019&utm_medium=Blog&utm_source=Mautic&utm_content=Using%20EquatIO%20with%20PDF%20reader%20-%20blog
https://www.texthelp.com/en-us/sectors/education/exams-and-assessment/
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XODO PDF Viewer and Editor 

Summary 

Xodo (Xodo, 2019) is a web app and a downloadable app that can run offline. Xodo provides core 

functions for reading and accessing SQA DQPs and PDF DABs — candidates can view the 

question papers, type into answer boxes, draw and annotate. However, there is no text reader built 

in and we could not get other text readers to work; and there is no Spellcheck and no Autosave. It 

may suit the needs of some candidates but has significant limitations for candidates who use 

Assessment Arrangements. 

Pricing 

Xodo is free for personal use.  

Question-only digital question papers 

Xodo is effective for opening and viewing DQPs, but no text-to-speech is provided, and text reader 

extensions that we tested such as ClaroRead and Read&Write did not function either. There may 

also be other text readers that do work with Xodo that we have not been able to find. The Xodo 

Android app is claimed to have a text reader, so this may be an option if your Chromebook can run 

Android apps.  

Question-and-answer digital question papers 

Xodo gives an effective experience for typing into answer boxes. However, there is no Spellcheck 

so it is not suitable for candidates who need spelling support. There is also no Autosave, although 

candidates can manually save to Goggle Drive or to the Chromebook itself. 

 

Examination arrangements 

The downloadable Xodo app can run offline if internet access is not available. Files can be loaded 

from Google Drive or from the device itself. There are no options to turn off Spellcheck (since there 

is no Spellcheck).  

Figure 47: Typing into answer boxes with Xodo 

https://www.xodo.com/
http://feedback.xodo.com/knowledgebase/articles/911262-how-does-xodo-make-money
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More Information 

 Xodo 

Text to speech voices for Chromebooks  

Chrome voices 

Chromebooks have built-in text to speech tools in the form of Select and Speak and ChromeVox; 

both can be used to read DQPs with the PDF viewers we tested, apart from Xodo. Chrome (at time 

of writing in August 2019) offers three UK English voices and a large number of other languages, 

but no Scottish voice is available. 

Acapela Chrome voices 

Voices from Acapela are now available for Chromebooks41, including the Scottish Rhona voice. The 

Acapela voices cost around £6 for an individual Google account. We do not know if school or 

domain licences are available. 

To purchase Rhona, download the Acapela Speech Engine from the Chrome Store and buy the 

voice, then set it to be the default voice for the device. The voice can then be used by Select and 

Speak and the other Chrome text to speech tools.  

CereProc Android Voices 

The Scottish CereProc voices are available for Android42 for 59p each, and this means they can be 

installed on those Chromebooks that can run Android apps. Unfortunately, the CereProc voices do 

not seem to work with any of the Chrome apps or extensions. 

 

 

 

41 Acapela voices for Chromebooks https://www.acapela-group.com/solutions/acapela-voices-for-

chromebooks/ 

42 CereProc voices for Android https://play.google.com/store/apps/developer?id=CereProc+Text-to-

Speech&hl=en_GB 

https://www.xodo.com/
https://chrome.google.com/webstore/detail/acapela-tts-engine/hfpbgbaepoblbkbmpojjnpkeikgoadil
https://www.acapela-group.com/solutions/acapela-voices-for-chromebooks/
https://www.acapela-group.com/solutions/acapela-voices-for-chromebooks/
https://play.google.com/store/apps/developer?id=CereProc+Text-to-Speech&hl=en_GB
https://play.google.com/store/apps/developer?id=CereProc+Text-to-Speech&hl=en_GB
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Comparison of apps/extensions for accessing digital question papers on 
Chromebooks 

 Chrome 
PDF 
Viewer 

DocsPlus Kami for Schools Snap&Read universal Texthelp PDF 
Reader 

Xodo 

Cost Free Annual subscription: £30 
single user; £500 school 
licence 

Contact Kami. $3.99/month for a 
personal licence (credit 
card only)  

Annual 
subscription: 
£150 single user; 
from £800 school. 

Free  

Open DQP Open from 
Google 
Drive or 
device 

Open from Google Drive 
or device 

Open from Google Drive 
or device 

Open from Google 
Drive, OneDrive or 
device 

Open from 
Google Drive or 
device 

Open from Google Drive 
or device 

Save DQP Yes  Yes  Yes Yes to the device; a 
new file created for 
each save. 

Yes, a new file 
created for each 
save.  

Yes, a new file created 
for each save unless 
manually renamed. 

Autosave 
DQP 

No Yes  Yes No  No No 

Open PDF 
DABs 

Yes Yes  Yes  Yes  Yes  Yes 

Open .docx 
DABs 

No No  No  No (use Docs and 
Snap&Read) 

No (use Docs and 
Read&Write) 

No 

View DQP and 
DAB side by 
side 

Yes No  Yes  Yes  Yes  Yes 

Printing Yes  No, for a DQP Yes  Yes  Yes  Yes  

Table 5: Chromebook apps and extensions for SQA digital question papers and PDF Digital answer booklets 
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Copy 
candidate ID 
on each page 

Yes  No  No  No  No  Yes 

Zoom / 
magnify 

Yes Yes  Yes  Yes  Yes Yes 

Reflow No No  No No No No 

Navigate with 
Bookmarks 
and page 
thumbnails  

Yes 

 

No  Yes Yes Yes Yes 

Page turn / 
scroll 

Touch; 
mouse; 
scroll bar; 
keyboard. 

Touch; mouse; 
keyboard. 

Touch; mouse; scroll bar; 
keyboard. 

Touch; mouse; scroll 
bar; keyboard. 

Touch; mouse; 
scroll bar; 
keyboard. 

Touch; mouse; scroll 
bar; keyboard. 

Change 
colours 

No No  No Yes - the colour 
overlay did not work in 
our tests; the line ruler 
did. 

No  No 

Read with 
computer text 
reader 

Yes, 
Chrome 
Select and 
Speak. 

Yes — use the DocsPlus 
reader or Select and 
Speak. 

Yes  Yes  Yes — a text 
reader is built in. 
There is also a 
ScreenShot 
Reader. 

No 

Voices 
available 

Chrome 
voices 
including 
UK female 
voice.  

5 with DocsPlus, many 
more with Select and 
Speak. 

Chrome voices including 
UK female voice. 

 

Chrome voices 
including UK female 
voice. 

 

US and UK 
voices Daniel and 
Serena.  

None 

Scottish 
computer 
voices 

Yes, by 
buying 
Acapela’s 
Rhona 
voice 

Yes, by buying 
Acapela’s Rhona voice 
and using Select and 
Speak. 

Yes, by buying Acapela’s 
Rhona voice. 

Yes, by buying 
Acapela’s Rhona 
voice. 

Yes — Fiona 
(Vocaliser) is 
available in 
Read&Write, and 
Acapela’s Rhona 
voice will also 

No 

https://www.callscotland.org.uk/blog/new-voices-for-your-chromebook/
https://www.callscotland.org.uk/blog/new-voices-for-your-chromebook/
https://www.callscotland.org.uk/blog/new-voices-for-your-chromebook/
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work if it has been 
purchased and 
installed. 

Modern 
Foreign 
Language 
voices 

Yes, many 
available 
from 
Chrome.  

Yes Yes  Yes  Yes  no 

Keyboard 
only access 

Good - 
Space and 
arrow 
keys; TAB 
between 
answer 
boxes. 

TAB between answer 
boxes but the keyboard 
cannot be used to move 
from page to page in the 
DocReader - candidates 
have to tap or click 
buttons.  

Good –keyboard 
shortcuts for annotations. 

Space; arrow keys to 
navigate. 

TAB to move between 
answer boxes.  

Limited —  

Space; arrow keys to 
navigate. 

You cannot TAB 
between answer 
boxes. 

 

Limited —  

Space; arrow 
keys to navigate. 

You cannot TAB 
between answer 
boxes. 

Good — Xodo has 
keyboard shortcuts for 
annotations. 

Space; arrow keys to 
navigate. 

TAB to move between 
answer boxes.  

Mouse only 
access 

Yes Yes  Yes Yes Yes Yes — via Chrome on-
screen keyboard. 

Type into 
answer boxes 

Yes  yes Yes.  

 

No. 

Use the Text tool to 
type ‘on top’ of the 
answer box. 

No. 

Use the 
Typewriter to type 
on top. 

Yes 

Tick boxes Yes  Yes  Yes No — draw or type a 
letter 

No — draw or 
type a letter. 

Yes 

Drawing tools Yes. 
Freehand. 

no Yes. 

Freehand; line; rectangle; 
circle. 

 

Yes. Line. Yes, freehand 
drawing; draw 
square, circle and 
lines. 

Yes. Freehand drawing; 
draw square, circle, line, 
arrowed line, connected 
line, polygon, cloud. 

Annotation 
tools 

No no Text, audio and video 
comment; text box; 
highlight; underline; 
strikethrough. 

Yes — highlight box.  Text comments, 
audio comments, 
highlighters. 

Yes. Highlighter; 
strikethrough; underline; 

insert note, insert image. 

http://feedback.xodo.com/knowledgebase/articles/1185256-keyboard-shortcuts
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Spellchecker No. Yes (DocsPlus) Yes (Chrome Spellcheck) Yes (Chrome 
Spellcheck) 

Yes (Chrome 
Spellcheck) 

No 

Literacy 
supports 

No. Word prediction, word 
banks. 

 

Dictionary / Lookup 
(internet required) 

Highlight and collect 
text from the paper to 
an outline. 

Define, Simplify Text, 
Translate tools. 

Word prediction, 
Picture 
Dictionary, Online 
Dictionary, 
highlighter to 
collect notes and 
quotes, translator 

No 

Computer 
dictation 

Yes, 
Google 
Dictation. 

Yes, Google Dictation. Yes, Google Dictation. 

 

Yes - you can dictate 
into a Text Box. 

Yes, you can 
dictate into a Text 
Box. 

Yes, Google Dictation. 

 

Insert maths 
& science 
expressions 

No No  Yes — equation editor. No  Yes, Texthelp’s 
Equatio equation 
editor. 

No 

Exam Mode / 
disable 
Spellcheck 
and writing 
supports 

N/A Yes  No  no No  N/A  

Offline use Yes Yes Yes  No  No  Yes  
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Technical administration of Chromebooks in SQA 
examinations  

Google suggest three techniques for configuring Chromebooks for assessment purposes43: 

Scenario 1: Single app kiosk 

The single app kiosk method44 restricts the candidate to using a single app or extension, such as 

Google Docs or Google Forms.  

It is not suitable for candidates who need to use more than one app, eg a PDF reader to read the 

question paper and/or a word processor to type answers, and/or an accessibility extension as well 

as the word processor.  

Kiosk apps require setting up and programming, and it is not clear whether centre staff have 

expertise to undertake the technical development of Kiosk apps.  

We do not think that the spellchecker and other literacy support tools can be disabled using this 

method unless a bespoke word processor or text editor app is created. 

Single kiosk app is therefore unlikely to provide a suitable approach for managing Chromebooks for 

candidates who require Assessment Arrangements in examinations.  

Scenario 2: Exam accounts 

With the exam accounts method45, the technical administrator in the presenting centre uses the 

Google Admin Console to set up accounts that allow candidates access to specific network or 

internet locations to access the DQPs and/or DABs, and restricts access to any other sources. 

These exam accounts also only permit the candidate to access the permitted apps and extensions 

that are required by the candidate for the examination.  

This method allows candidates to access the DQPs, to use accessibility extensions, and to type up 

answers with a word processor. Of the three scenarios suggested, it therefore offers most of the 

functionality required for using Chromebooks for Assessment Arrangements. Some technical notes 

on using this technique are offered in Appendix 1. 

However, we have not been able to find a way to disable the Chrome spellchecker, so this 

technique is not suitable for candidates who do not have permission to use these facilities. 

 

43 Use Chromebooks for student assessments, https://support.google.com/chrome/a/answer/3273084?hl=en  

44 Scenario 1: School sets up Chromebook to run as a Single App Kiosk running the exam app. 

https://support.google.com/chrome/a/answer/3273084?hl=en  

45 Scenario 2: Testing provider sets up student accounts for assessment. 

https://support.google.com/chrome/a/answer/3273084?hl=en#  

https://support.google.com/chrome/a/answer/3273084?hl=en
https://support.google.com/chrome/a/answer/3273084?hl=en
https://support.google.com/chrome/a/answer/3273084?hl=en
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Scenario 3: Public session kiosks 

In a public session kiosk46, candidates taking the examination are allocated into organisational units. 

Specific policies, settings and resources are applied to the accounts within the organisational unit47 

and candidates are given access to files and resources required to access the examination. The 

main difference between this method and the previous scenario is that here, students log on to the 

public session with their own account, whereas in Scenario 2 they use the exam account.   

Multiple apps, windows and extensions can be used in public session devices, which means that a 

candidate could for example view a DQP and type up answers with a word processor or text editor. 

It should also be possible to run accessibility extensions.  

Again, the Google Admin Console is used to configure the permitted extensions, settings and 

permissions, and so we do not think that it is possible to prevent access to the spellchecker and 

other literacy supports. 

Summary 

Having investigated the three methods suggested by Google, we think that the most suitable 

method is to use the Google Admin Console to set up accounts for use in examinations — Google 

Option 2. We have created an initial document that sets out the procedure for setting up 

Chromebooks for Digital Exams (Appendix 1). This requires testing and refinement by centres 

before it can be published as guidance. 

 

  

 

46 Scenario 3: School sets up Public Sessions with student devices; Manage public sessions devices, 

https://support.google.com/chrome/a/answer/3017014  

47 Set Chrome policies for users, https://support.google.com/chrome/a/answer/2657289  

https://support.google.com/chrome/a/answer/3017014
https://support.google.com/chrome/a/answer/2657289
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Commercial assessment / examination software  

A number of software vendors offer tools for delivering and administering assessments and we have 

investigated some of the options. 

BTL Surpass 

http://www.btl.com/  

SQA has been working with BTL on e-Assessment systems for many years48 and piloted the BTL 

SurpassPaper+ (http://www.btl.com/surpass/paperplus/) system in 2015–16, which is a ‘a secure 

word processing app designed specifically for examinations’. Essentially, it is an online digital 

answer booklet for candidates to type up answers, which locks the candidate in to the assessment 

and restricts access to tools and features that are not permitted, such as spellchecking. However, 

neither SurpassPaper+ nor the main Surpass e-Assessment operate Chromebooks.  

ChromeEx  

https://www.chromex.io/en  

ChromeEx is an application for ‘creating, administering and assessing digital exams in schools and 

educational institutions’. It runs in the Google G Suite environment. 

ChromeEx runs as a kiosk app (see Scenario 1: Single app kiosk) and allows the candidate to view 

a PDF question paper and type up answers in a word processor. The application can disable the 

spellchecker. Candidates cannot type into answer boxes or otherwise interact with the paper, and 

so it is not suitable for use with question-and-answer DQPs. We do not know if the Chrome Select 

and Speak tool functions in ChromeEx and ChromeEx does not permit extensions to run, so 

accessibility tools such as Read&Write etc cannot be used. 

DigiExam  

https://www.digiexam.com/  

DigiExam is an online secure assessment system that works on Windows, MacOS, iOS and 

Chromebooks. It works in Public Kiosk mode49 and requires Chromebooks to be managed with the 

Admin Console. Like ChromeEx, it is primarily designed for creating complete examinations and 

assessments for online delivery, where questions are presented and candidates respond by typing 

answers to each question. PDF files can be viewed within a DigiExam assessment, and it has a text 

reader and spellcheck that can be enabled or disabled for specific candidates and examinations, so 

it could be appropriate for examinations where candidates are using technology to type up answers, 

and/or read a question-only DQP.  

 

48 SQA renews e-Assessment contract with BTL Group https://www.sqa.org.uk/sqa/90399.html 

49 DigiExam Installation Guide — Managed Chromebooks https://digiexam.zendesk.com/hc/en-

us/articles/202305421-Installation-guide-Managed-Chromebooks  

http://www.btl.com/
http://www.btl.com/surpass/paperplus/
https://www.chromex.io/en
https://www.digiexam.com/
https://www.sqa.org.uk/sqa/90399.html
https://digiexam.zendesk.com/hc/en-us/articles/202305421-Installation-guide-Managed-Chromebooks
https://digiexam.zendesk.com/hc/en-us/articles/202305421-Installation-guide-Managed-Chromebooks
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It is not suitable for question-and-answer DQPs because answers cannot be typed into the answer 

boxes.   

 

 

DigiExam was used by Swedish students for national Swedish and English examinations in 201750, 

and their case stories are available on the DigiExams website: https://www.digiexam.com/stories/. 

WISEflow 

https://europe.wiseflow.net/  

WISEflow is another online assessment and examination delivery platform but the LockDown 

browser that is used for secure examinations is not available for Chromebooks. 

Chromebooks in examinations in practice  

An Internet search was conducted to research reported practices and experiences of using 

Chromebooks in assessments and examinations. 

Using Chromebooks for exams 

Dean Stokes’ method involves using Google Forms within a public session kiosk. This would not 

give access to DQPs, and it is not clear whether the spellchecker and other literacy tools can be 

disabled for candidates who are not permitted to use them. The blog notes that this method has not 

as yet been used in practice for examinations.  

 http://blog.deanjstokes.co.uk/2015/02/using-chromebooks-for-exams.html 

 

50 Swedish National Exams 2017 https://www.digiexam.com/company/blog/swedishnationalexams2017/  

Figure 48: DigiExam has a text reader facility 

https://www.digiexam.com/stories/
https://europe.wiseflow.net/
http://blog.deanjstokes.co.uk/2015/02/using-chromebooks-for-exams.html
https://www.digiexam.com/company/blog/swedishnationalexams2017/
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Setup solution: Chromebooks for exams 

Oli Trussell proposes creating a public kiosk session with an HTML editable page, with the 

possibility of answer boxes. Oli has created answer booklets with answer boxes and custom 

headers. It is not clear whether DQPs could be accessed or whether the literacy tools can be 

disabled. 

 http://schoolsmartcloud.blogspot.co.uk/2016/10/setup-solution-chromebooks-for-exams.html 

 https://docs.google.com/document/d/1TRTpQkbnClJHLZQfW5PKYTdYn5wMzhBpjER0LKPOUJ

w/edit 

Chromebooks for assessment and in-class use: a pilot study  

A 2015 project report from the Department of Curriculum and Quality Enhancement at the University 

of Portsmouth details procedures for device set-up and management and workflows for 

administering examinations. The pilot project used ‘Containers’ to set up exam profiles and the 

actual assessments were undertaken using tools such as Google Forms. 

 http://www2.port.ac.uk/departments/services/dcqe/storeddocuments/filetodownload,190319,en.p

df 

Chromebook e-exams 

Guidance from the Tech for Learning Service in Victoria, British Columbia, Canada, on using kiosk 

mode for examinations. The Guide for Adjudicators is a good example of the type of resource that 

would be helpful for SQA examinations. The guide notes, however, that the Read&Write extension 

that provides access to text to speech and other literacy support tools is not compatible with the 

exam mode and therefore if a student requires it, he or she will require ‘enhanced supervision’. 

 https://techforlearning.sd61.bc.ca/learning-with-chromebooks/exams/  

 https://techforlearning.sd61.bc.ca/wp-content/uploads/sites/107/2018/01/PROVINCIAL-EXAMS-

Technical-guide-for-Adjudicators.pdf 

 

 

  

http://schoolsmartcloud.blogspot.co.uk/2016/10/setup-solution-chromebooks-for-exams.html
https://docs.google.com/document/d/1TRTpQkbnClJHLZQfW5PKYTdYn5wMzhBpjER0LKPOUJw/edit
https://docs.google.com/document/d/1TRTpQkbnClJHLZQfW5PKYTdYn5wMzhBpjER0LKPOUJw/edit
http://www2.port.ac.uk/departments/services/dcqe/storeddocuments/filetodownload,190319,en.pdf
http://www2.port.ac.uk/departments/services/dcqe/storeddocuments/filetodownload,190319,en.pdf
https://techforlearning.sd61.bc.ca/learning-with-chromebooks/exams/
https://techforlearning.sd61.bc.ca/wp-content/uploads/sites/107/2018/01/PROVINCIAL-EXAMS-Technical-guide-for-Adjudicators.pdf
https://techforlearning.sd61.bc.ca/wp-content/uploads/sites/107/2018/01/PROVINCIAL-EXAMS-Technical-guide-for-Adjudicators.pdf
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Appendix 1: Setting up Chromebook accounts for SQA 
Examinations  

Check with your Local Authority Education ICT team to see if your authority already has a domain 

and have signed up to the G Suite for Education Programme through Glow. If so, follow their 

directions for setting up Chromebooks for exam purposes. 

Here are our guidelines if you are starting from scratch. 

Step 1. Set up Chromebooks for use in examinations 

1 Set up a domain name for your school. 

2 Sign up to Google’s G Suite for Education Programme 

3 Purchase a Chrome Education licence for each device. 

4 Set up Google accounts for each Chromebook. 

5 Use the Google Admin Console to setup the Chromebooks. 

1 Set up a domain name for your school 

It is a requirement to have the G Suite account registered against as a domain name, eg 

www.myschool.org.uk. Speak to your local authority IT department on how best to do this. (One 

suggested site for creating domains is https://www.1and1.co.uk/) 

2 Sign up to Google’s G Suite for Education Programme 

The G Suite for Education programme is free and is designed for schools to manage Chromebooks 

using the Google Admin console (see step 5). Go to google.com/a/cpanel/education/new to start the 

sign-up process. 

   
 Image 1: G Suite for Education programme sign-up screen 

 

http://www.myschool.org.uk/
https://www.1and1.co.uk/
https://google.com/a/cpanel/education/new
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3 Purchase a Chrome Education licence for each device  

So that the Chromebooks can be managed through the Google Admin Console. The cost for the 

licence is:  

 Perpetual - £23 

See: support.google.com/chrome/a/answer/2717664?hl=en 

4 Set up Google Accounts for each Chromebook 

1 Set up email addresses using the registered domain from step 1 (eg exam1@myschool.org.uk) 

since each Google ‘exam’ account needs an email address it can be registered against. 

2 Create a Google account for each Chromebook using the email address above. Go to 

accounts.google.com/SignUp to start the sign-up process. 

  
Image 2: Google account sign-up screen 

5 Use the Google Admin Console to setup the Chromebooks 

Use the console to: 

 5.1 Enrol Chromebooks. 

 5.2 Add Users. 

 5.3 Restrict access to the internet. 

 5.4 Install apps and extensions. 

 5.5 Configure ‘pinned’ apps. 

 5.6 Set up printing. 

5.1 Enrol Chromebooks 

1 Turn on the Chromebook and follow the onscreen instructions until you see the sign-in screen. 

Don't sign in yet. 

2 Press Ctrl+Alt+E to go to the enrolment screen. 

3 Enter the username and password for a Google ‘exam’ account that has eligibility to enrol. 

https://support.google.com/chrome/a/answer/2717664?hl=en
file:///C:/Users/Shirley/AppData/Local/Microsoft/Windows/INetCache/Content.Outlook/MDQ6ZC3B/accounts.google.com/SignUp
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5.2 Add users 

1 Log in to the Google Admin Console (admin.google.com). 

2 Navigate to Users. 

3 Click on the yellow plus sign in the bottom left of the screen. 

4 Select Add user. 

5 Enter the user details (Google ‘exam’ account email address) and press Create. 

 

 
Image 3: Add Users page 

5.3 Restrict access to the internet 

Block all URL access except those required: 

1 Click on Google Admin (top left) to get back to the Home Page. 

2 Navigate to Device management>Chrome Management>User Settings. 

3 Scroll down to URL Blocking section (or use CTRL+F to bring up a search box to find what you 

are looking for rather than scrolling down the very long list). 

4 Under URL Blacklist add the following two entries to block everything: http://* and https://* 

5 Under the URL Blacklist Exception you can now add URLs that you want to allow access to 

such as https://docs.google.com/. 

file:///C:/Users/Shirley/AppData/Local/Microsoft/Windows/INetCache/Content.Outlook/MDQ6ZC3B/admin.google.com
https://docs.google.com/
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Image 4: URL Blocking 

5.4 Install apps and extensions 

Before you can manage specific Chrome apps and extensions, you need to turn on the Chrome 

Web Store: 

1 Click on the 3 horizontal lines (top left of screen). 

2 Go to ‘Apps > Additional Google Services’.  

3 Click the name of the service (ie myschool.org.uk). 

4 At the right of ‘Chrome Web Store’, click ‘More Settings’ (3 vertical dots) and choose ‘ON for 

everyone’. 

Now automatically add Apps and Extensions to Chromebooks: 

1 Click on ‘Google Admin’ (top left) to get back to the ‘Home Page’. 

2 Navigate to ‘Device management>Chrome Management>User Settings’. 

3 Scroll down to ‘Apps and Extensions’ section. 

4 To ‘force-install’ apps and extensions, click ‘Manage force-installed apps’. 

5 Click on Chrome Web Store. 

6 Search for the apps or extensions that you want to automatically install on devices and click 

‘Add’. 

7 Click ‘Save’. 
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Image 5: Add Apps and Extensions 

 
Block all apps and extensions except your ‘allowed apps’: 

1. Navigate to ‘Device management>Chrome Management>User Settings’. 
2. Scroll down to ‘Allow or Block All Apps and Extensions’. 
3. Select ‘Block all apps and extensions except the ones I allow’ from the 

dropdown menu 
4. Under ‘Allowed Apps and Extensions’ select the apps or extensions that 

you want to allow and click ‘Add’. 

 
Image 6: Allow certain apps 

 
 

5.5 Configure ‘pinned’ apps 

The bar at the bottom of the Chromebook is referred to as the ‘Shelf’. 

 

Navigate to Device management>Chrome Management>User Settings. 

Scroll down to Pinned Apps and Extensions. 

Select the apps or extensions that you want to automatically pin to the shelf and click Add. 

Click Save. 

We’ve found that accessing files using Google Drive on Google Chrome can cause a few issues: 

 Can be slow and unresponsive. 
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 Word Documents cannot be directly opened in Google Docs. They must be downloaded first and 

then opened in Google Docs. 

Using the File browser, you can browse Google Drive, and Word documents can be opened directly 

in Google Docs from Google Drive. 

 

Since the File browser is not an app, you add it as a custom app. Add the File browser to the Shelf 

as follows: 

1 Navigate to Device management>Chrome Management>User Settings. 

2 Scroll down to Pinned Apps and Extensions. 

3 Select Specify a Custom App. 

4 Enter the ID exactly as shown: hhaomjibdihmijegdhdafkllkbggdgoj 

5 Enter the URL as: http://clients2.google.com/service/update2/crx 

6 Click Add. 

7 Click Save. 

 

 

Image 7: Specify a custom app 

5.6 Set up printing 

Before you can print, a network printer needs to be added: 

1 Click on Google Admin (top left) to get back to the Home Page. 

2 Navigate to Device management>Chrome Management>User Settings. 

3 Scroll down to Printing section. 

4 Under Native Chrome OS Printing click on Manage. 

5 A pop-up box will appear, click on Add a Printer and enter the details. 
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Image 8: Adding a printer 

The printer will now be available for printing from all Chromebooks.  
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Step 2. Making digital question papers available to the Chromebook 

We decided that Google Classroom did not meet requirements of simplicity since the user would 

have to download the work files and make a copy within their Google Drive to save the paper. 

Copying the files straight to the Google ‘exam’ account seemed the most straightforward solution. 

1 Open the CD from the SQA or download the digital exam paper onto the computer (‘Admin 

computer’) which is being used with the Google Admin console. 

2 Log in to each Google ‘exam’ account on the Admin computer (eg exam1@myschool.org.uk).  

3 Click on the 9 squares to access Google Drive. Upload the digital exam paper (New / File 

Upload). 

 

Image 9: Google drive 
 

 
Image 10: Uploads on Google Drive 
 
The digital exam paper has now been successfully uploaded to My Drive in the ‘exam’ Google 

Account. 

Step 3. How to access the digital paper on the Chromebook 

1 Examiner / teacher switches on the Chromebook and logs into the Google ‘exam’ account.  

 
NOTE: Examiner / teacher will know the password of the exam ‘account’ but it will not be given to 

the candidate. 

 

https://myaccount.google.com/
mailto:exam1@myschool.org.uk
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Image 11: Chromebook login screen 

2 Candidate clicks on the File browser icon  which is sitting on the ‘shelf’. 

 

3 Click on Google Drive >My Drive in the top left-hand side of the screen to find the exam paper. 

4 Double click on the exam paper. 

5 Choose the ‘Open with’ option above the exam paper and choose the preferred app/extension. 

 

Image 12: PDF preview 
NOTE: The default editor can also be set so that step 5 isn’t required. 

What the candidate does during the exam 

 Complete exam paper using the literacy support tools in selected app / extension — see other 

documentation for details. 

 If using Kami, click on Save / Save Now periodically; or use ‘Autosave’ if you have the paid 

version of Kami. 
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What to do when the exam is complete 

 Candidate clicks on (Kami) Save / Save Now to complete saving process. Closes exam paper 

and leaves the device. 

 Examiner / teacher logs into ‘exam’ account with ‘exam’ account email and password from any 

device. Go to Google Drive. Click on exam paper. Choose ‘Open with’ preferred app eg Kami. 

Choose print icon. 
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Appendix 2: Chrome PDF Viewers 

Feature Chrome (Online) PDF Viewer and Offline PDF Viewer 

Open DQP 

Online Viewer: double click to open from Google Drive in the browser window. 

Offline Viewer: Open from Google Drive, download to the Chromebook then 

open in the offline PDF Viewer. 

Save DQP 
Yes, click Download or Ctrl-S. This is effectively a ‘Save as’ function - you 

have to choose to replace the current file or give it a new name.  

Autosave DQP No. 

Open PDF 

DABs 
Yes, answers can be typed in and saved. 

Open .docx 

DABs 
No 

Autosave DAB No 

View DQP and 

DAB side by 

side 

Yes, the DQP and word processor for typing answers can be viewed side by 

side or top and bottom. 

 

 

 
 

Printing Yes, the DQP with answers and DAB PDFs can be printed. 

Copy 

Candidate ID 

on each page  

Yes. 

Exam Mode / 

disable 

Spellcheck and 

writing 

supports 

 No. 

Offline use Yes  
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Zoom / magnify Yes — (small) buttons to zoom in and out.   

Reflow to fit 

screen? 
No 

Navigate with 

Bookmarks and 

page 

thumbnails? 

Yes. 

 

  

Page turn / 

scroll 
Touch; mouse scroll; scroll bar; keyboard Spacebar; arrow keys. 

Change 

colours 
No. 

Read with 

computer text 

reader 

Yes. 

 

The built-in Chromebook Select and Speak worked well and this may be a 

viable option for reading DQPs in examinations. The text reader works when 

the device is disconnected from the internet. 

 

 

 

Read&Write did not work with the  PDF Viewer in our tests. 
 

Voices 

available 

Standard Chrome voices: male and female UK (English) accents. Acapela 

voices can also be purchased. 

https://support.google.com/chromebook/answer/9032490?hl=en-GB
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Scottish 

computer 

voices 

Yes, by buying Acapela’s Rhona voice. 

MFL computer 

voices 
Yes, many languages are available free with Chrome. 

Keyboard only 

access 
Space and arrow keys to navigate. TAB between answer boxes. 

Mouse only 

access 
Yes - via the Chrome on-screen keyboard. 

Type into 

answer boxes 

Yes. The answer boxes behave much like Adobe Reader on Windows: the 

borders are red until the candidate clicks in one to start typing; they are 

opaque, so any handwriting guides are not seen; and if the candidate fills the 

field with text the font starts to reduce in size to fit the text in the box.. 

 

 

 
 

Tick boxes Yes. 

Drawing tools 

Yes. Online Viewer has freehand pen and felt pens. The Online Viewer has  

 

drawing; draw square, circle and line. 

We found there was a significant delay after clicking the Annotation button 

before the toolbar appeared, and sometimes the Viewer would crash before 

the Toolbar appeared.. 

 

 

https://www.callscotland.org.uk/blog/new-voices-for-your-chromebook/
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The offline viewer has a Comment tool but comments are not printed. 

  

Annotation 

tools 
No apart from drawing as above. 

Spellchecker 
 

No: words are underlined but no spellcheck list is offered. 

Literacy 

supports 
No. 

Computer 

dictation 
Yes, use Google Dictation. 

Insert maths & 

science 

expressions 

No. 
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Appendix 3: DocsPlus 

Feature DocsPlus 

Open DQP Open from Google Drive or from the Chromebook files into the DocReader. 

Save DQP Yes 

Autosave DQP  Yes - changes are automatically saved. 

Open PDF DABs 

Yes, although you cannot open both the DQP and the DAB in DocReader at 

the same time, which means it is not a viable option for candidates who need 

to use both. The amount of text that can be typed into an answer box seems 

too limited for practical use. 

Open .docx DABs No — use the Document word processor and save as DocsPlus or .docx file. 

Autosave DAB Yes 

View DQP and 

DAB side by side 

No — you cannot view the paper and answers at the same time. Also, you 

cannot copy a question from the DQP and paste it into the document as an 

aide-memoire for answering the question. 

Printing 

Yes — for a Document. 

No — for a DQP. The file can be opened in another PDF reader for printing, 

or emailed, but the answers did not appear properly in the Chrome PDF 

reader (see below), although we found that the text could be seen in Kami. 

 

 

 

Copy Candidate 

ID on each page  

DQP — No, the candidate number is not copied to each page in the DQP. 

DAB — No, there are no headers or footers in the Document window so 

candidate information cannot be copied to each page. 

Exam Mode / 

disable 

Spellcheck and 

writing supports 

Yes. The Exam Mode can enable or disable the word bank, prediction, 

spellchecking, speech, DocReader and editing options. 
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Offline use Yes  

Zoom / magnify 

Yes. Tap the View button and use the slider or Fit Width / Fit Page. 

 

 

 

The maximum font size is not particularly large — about 14-16 point on the 

test Asus with 10’ screen. 

 

 

 

Reflow to fit 

screen? 
No 
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Navigate with 

Bookmarks and 

page thumbnails?  

No. 

 

Page turn / scroll Click buttons to navigate between pages. Once on a page the arrow keys 

and Space bar can scroll the page. 

Change colours No. The background and text colour of the PDF cannot be changed in 

DocReader. (They can in the DocsPlus document when writing answers.) 

Read with 

computer text 

reader 

Yes — a good text reader is provided in DocReader. Select the text and click 

the Play button. Each word is highlighted as it is read.  

 

 

 

Chrome’s Select and Speak can also be used to read the DQP. 

 

Voices available 

Chrome UK voices and Acapela Rachel. 

 

 

Scottish 

computer voices? 

Not for the DocsPlus text reader, but the Chrome Select and Speak tool can 

be used to read the DQP in DocsPlus, and the Rhona Scottish voice is 

available for around £6 per account. 

MFL computer 

voices? 
Not known with DocsPlus; many with Select and Speak. 

Keyboard only 

access 

Candidates can TAB between answer boxes but the keyboard cannot be 

used to move from page to page in the DocReader - candidates have to tap 

or click buttons. Arrow keys and space bar can be used to navigate within 

the page. 
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Mouse only 

access 

Yes — DocsPlus has its own onscreen keyboard with the option of 

SuperKeys for people with visual or physical challenges. The Google OSK 

can also be used. 

 

 

 

 

Type into answer 

boxes? 

Yes. Answers can be typed into answer boxes in the DQP, with support from 

the word predictor and spellchecker. The text size seems quite large and the 

text scrolls up as more text is typed in, which means that even if the PDF 

could be printed, the printout would only show the visible text. DocsPlus is 

therefore not recommended for Question-and-answer DQPs. 

 

 

 

Tick boxes? Yes  

Drawing tools? No 
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Annotation tools? None 

Spellchecker? Yes — talking spellchecker 

Literacy supports 

Word prediction, word banks, spellchecker, computer text reader. 

The literacy support tools can be used in both documents and for typing into 

DQP answer boxes. The words in the predictor and other tools can be 

spoken out. 

 

Word predictor 

 

 

The predictor uses ‘flexible spelling’ so that it can handle spelling errors. 

 

Spelling errors are identified with a red line - click on the word to see 

suggestions. 

 

 

The wordbar feature offers word bank support. Wordbars can be created for 

particular topics and ready-made wordbars are available on the Crick 

Learning Grid website. 



85 

 

Computer 

dictation 
Yes, Google Voice typing can be used in a Document and to dictate into a 

DQP in the DocReader. 

Type maths & 

science 

expressions 

No 
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Appendix 4: Kami 

Feature Kami 

Open DQP Open from Google Drive or from the Chromebook files.  

Save DQP Yes 

Autosave DQP Yes 

Open PDF DABs Yes 

Open .docx DABs No 

Autosave DAB Yes — PDF DABs 

View DQP and 

DAB side by side 

Yes, drag one tab to a separate location on screen, click and hold on the 

Maximise button until you see the two horizontal arrows, then choose either 

the left or right arrow to dock the window. Drag and re-size the windows 

manually if you want to see them on top and bottom of the screen. 

Printing Yes. 

Copy Candidate 

ID on each page 

No, the ID is not automatically copied across each page. 

  

Exam Mode / 

disable 

Spellcheck and 

writing supports 

 No. 

Offline use  Yes  

Zoom / magnify Yes — click the + and - buttons on the toolbar to zoom in and out, or press 

CTRL- or CTRL+ or use Zoom Options button and choose to view a Full 

page, Page Width, or zoom up to 400%. 

Kami cannot reflow the paper at high levels of zoom and so you will need to 

scroll horizontally to read the paper. 
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Reflow to fit 

screen? 

No. 

Navigate with 

Bookmarks and 

page 

thumbnails? 

Yes. 

  

Page turn / scroll Touch; mouse scroll; scroll bar; keyboard Spacebar; arrow keys. 

Change colours No. 

Read with 

computer text 

reader 

Yes — click the Text to Speech button, select the text and it will be read out 

with each word highlighted as it is read. Kami does not seem to be able to 

read answers typed into answer boxes.  

 

 

 
Voices available A range of voices, but only one UK (female) English voice.  
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Scottish 

computer 

voices? 

Yes, by buying Acapela’s Rhona voice. 

MFL computer 

voices? 

Yes. 

Keyboard only 

access 

Space and arrow keys to navigate; TAB between answer boxes. 

Mouse only 

access 

Yes — via the Chrome on-screen keyboard. 

Type into answer 

boxes 

Yes. Kami does not show the red borders on the answer boxes and the 

boxes are pale grey. The boxes are transparent, and any handwriting 

guides are visible, which may be distracting for some candidates. 

 

 
Tick boxes Yes. 

Drawing tools Yes. Freehand drawing; draw square, circle and line. 

Annotation 

tools? 

Yes. Highlighter; strikethrough; underline; insert Text, voice, video, screen 

capture Comments, Text Box, Equation; insert image. 

 

 
Spellchecker? 

 

Yes. Built-in Chrome spellchecker. Select a word and right click to see 

spellchecker suggestions. 

https://www.callscotland.org.uk/blog/new-voices-for-your-chromebook/
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Literacy supports Right click and use Google Lookup (if connected to the internet). 

Computer 

dictation 

Yes, use Google Dictation. 

Type maths & 

science 

expressions 

Yes, Kami has an equation editor that can be used to add an equation on 

top of an answer box. 
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Appendix 5: Snap&Read PDF Reader 

 

Feature Snap&Read PDF Reader 

Open DQP Open from Google Drive, OneDrive or from the Chromebook. 

Save DQP Yes, to the device itself. Saving to Google Drive on OneDrive did not function 

on our test machine. A new file is created each time the file is saved, which 

may be confusing for candidates. 

Autosave DQP  No 

Open PDF DABs Yes  

Open .docx 

DABs 

No — but Snap&Read can read from Google Docs. 

Autosave DAB No  

View DQP and 

DAB side by side 

 

Yes. 

Printing Yes, answers typed on a DQP can be printed. 

Copy candidate 

ID on each page  

No 

Exam Mode / 

turn off 

Spellcheck and 

support tools 

No  

Offline use No  

Zoom / magnify Yes, zoom in and out; fit width and fit page. 

Reflow to fit 

screen? 

No  

Navigate with 

Bookmarks and 

page 

thumbnails?  

Yes. 

 

Page turn / scroll Touch; mouse scroll; scroll bar; keyboard Spacebar; arrow keys. 

Change colours Yes and no - there is a colour overlay feature but we could not get it to work. 

There is also a line reading ruler which did function. 
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Read with 

computer text 

reader 

Yes. Snap&Read has a useful text reader. Either turn it on and click on text 

and the reader will read from that point, or select the text and click Speak. 

 

 
Voices available A range of (online) voices are offered, and the Chrome UK voices can also 

be used. 

 

Scottish 

computer 

voices? 

No 

MFL computer 

voices? 

Yes, a range of free eSpeak and Chrome voices. 

Keyboard only 

access 

Limited — Space; arrow keys to navigate. You cannot type into or TAB 

between answer boxes. 

Mouse only 

access 

yes 

Type into answer 

boxes? 

No.  

Snap&Read does have a Text Comment tool which can be used to type on 

top of the PDF. We found that we could not type on top of an answer box, 

but it did work if we started typing outside the box. Candidates will have to be 

careful to re-size their answers so that they do not exceed the scanned area 
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of the page. The feature is more complex than typing into answer boxes. The 

font, colour, size, style and alignment can be set. 

 

 
Tick boxes? No - use the line tool or Text Comment. 

Drawing tools? Yes - Line Tool. 

 
Annotation 

tools? 

Yes - highlight box. 

Spellchecker? Yes - the built in Chromebook spellcheck. 

Literacy support  Yes. 

Snap&Read has an Outline feature which can be used to capture text from 

the DQP. This could be useful for taking notes during an exam. 

 

There is a Define tool that provides a definition of a word, with symbol 

support. 



93 

 

Snap&Read has a tool to simplify text, which would probably not be 

permitted in an examination. 

 

There is a Translate Tool, which again would not be permitted in an 

examination. 

 
Computer 

dictation 

Yes - Google Dictation works with the Text Comments. 

Type maths & 

science 

expressions 

No  
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Appendix 6: Texthelp PDF Reader 

Feature Texthelp PDF Reader 

Open DQP Open from Google Drive or the Chromebook files. 

Save DQP Yes, although a new file is created with each save, and so candidates will 

generate multiple copies and care will be required to ensure the most 

recent version is printed. 

Autosave DQP  No 

Open PDF DABs PDF — yes, open and use the Typewriter to type on top.  

 

Open .docx DABs No — use a word processor and Read&Write. 

Autosave DAB No 

View DQP and DAB 

side by side 

Yes — position the windows as needed.  

Printing Yes. 

Copy candidate ID 

on each page 

No. 

Exam Mode / 

disable Spellcheck 

and writing 

supports 

No. 

Offline use No  

Zoom / magnify Yes. Zoom in and out by touch or use +/- buttons, and Fit Width, Fit Page, 

or choose a zoom value. 

Reflow to fit 

screen? 

No 

Navigate with 

Bookmarks and 

page thumbnails?  

Yes — the bookmarks are displayed at the left of the screen. Page 

thumbnails can also be shown to aid navigation around the paper. 
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Page turn / scroll Touch; mouse scroll; scroll bar; keyboard Spacebar; arrow keys. 

Change colours No.  

Read with 

computer text 

reader 

Yes — the PDF Reader text to speech is a strength of the product and is 

available in both free and premium subscriptions.  

There are two modes of operation. First is to select some text and click the 

Play button, and the text will be read out and highlighted as it is read. The 

second is to turn on Click to Speak then click or tap on a sentence and it 

will be read out. There is an option for Continuous Reading where the 

reader will then go on and read the next sentence until the Pause or Stop 

button is clicked. In an exam Click and Speak is faster and more 

convenient than the select and speak method. The reader highlights the 

sentence being read and each word as it is read out. 

 

Screenshot reader: A Screenshot Reader is provided for ‘image text’ that 

cannot be read out by the text reader because it is not actual text. All SQA 

papers have readable text, so this should not be required in SQA 

examinations but it may be useful for other files. To use the ScreenShot 

Reader, draw a box round the text and after a short delay, it will be read 

out. 

Voices available Range of UK and US voices. 
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Scottish computer 

voices? 

Yes — Fiona (Vocaliser) is available in Read&Write, and Acapela’s Rhona 

voice will also work if it has been purchased and installed on the 

Chromebook. 

MFL computer 

voices? 

Yes, in various languages. 

Keyboard only 

access 

Limited. Space; arrow keys to navigate. 

You cannot type into or TAB between answer boxes. 

Mouse only access Yes - via the Chrome on-screen keyboard. 

Type into answer 

boxes? 

No. Candidates cannot click and type into the form fields on the PDF.  

With Premium, the Typewriter tool can type ‘on top’ of answer boxes. This 

is not as convenient as actually typing into the answer box and users 

cannot click on a tick box or Tab between answer boxes; and any text 

outwith the fiducials on the page will not be scanned by SQA’s e-marking 

system. 

On the other hand, the Typewriter does have advantages compared to the 

standard PDF form fields: 

 The text box created by the Typewriter tool can be moved and resized, 

and the font size and colour can be changed.  

 Answers can be read back with the Play button 

 Users can dictate into the answer box using speech recognition 

 Users can use word prediction. 

 

The free version does have a comment tool but it is not suitable for the 

DQPs because comments are not printed. 

Tick boxes? No — you have to type an X on top, draw freehand or draw a shape round 

the answer. 

https://www.callscotland.org.uk/blog/new-voices-for-your-chromebook/
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Drawing tools? Yes, freehand drawing; draw square, circle and lines (premium 

subscription). 

Annotation tools? Text comments, audio comments, highlighters (premium subscription). 

Use the highlighters to mark-up quotes and text from a DQP which can be 

collated automatically in a Google Doc. 

Spellchecker? Yes. Standard Chrome spellchecker - select a word and right click to see 

spellchecker suggestions. 

Literacy supports Word prediction, Picture Dictionary, Online Dictionary, highlighter to collect 

notes and quotes, translator. 

Dictionary: 

 

Picture Dictionary (Widgit symbols): 

 

Computer dictation Yes, candidates can dictate into the Typewriter with Talk&Type. 

Type maths & 

science 

expressions 

Yes, via TextHelp’s Equatio which provides an equation editor with 

handwriting recognition and prediction. 

 

 

 

https://www.texthelp.com/en-gb/products/equatio/
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Appendix 7: Xodo 

Feature Xodo 

Open DQP Open from Google Drive or from the Chromebook files.  

Save DQP 
Yes — Save will automatically create a new file each time unless you 

rename it manually. 

Autosave DQP No  

Open PDF DABs Yes 

Open .docx DABs No 

Autosave DAB No. 

View DQP and 

DAB side by side 

Yes. 

 

 

 
Printing Yes. 

Copy Candidate 

ID on each page 
Yes- the ID is automatically copied across each page. 

Exam Mode / 

disable 

Spellcheck and 

writing supports 

 No. 

Offline use No  

Zoom / magnify Yes - buttons for Full Page and Page Width, and zoom in and out.  
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Reflow to fit 

screen? 
No 

Navigate with 

Bookmarks and 

page thumbnails? 

Yes. 

  

Page turn / scroll Touch; mouse scroll; scroll bar; keyboard Spacebar; arrow keys. 

Change colours No. 

Read with 

computer text 

reader 

No. Xodo for Chromebook does not provide a built-in text reader. We could 

not get the Chromebook Select to Speak, Read&Write or ClaroRead 

Chrome to read from a PDF in Xodo.  

(Xodo for Android is claimed to have a text to speech facility, and you can 

buy the Scottish Voices for 59p each for Android, so this may be an option 

if your Chromebook can run Android apps. 

Voices available N/A 

Scottish computer 

voices? 
N/A 

MFL computer 

voices? 
N/A 

Keyboard only 

access 

Good — Xodo has keyboard shortcuts for annotations. Space; arrow keys 

to navigate. TAB to move between answer boxes. 

Mouse only 

access 
Yes - via the Chrome on-screen keyboard. 

Type into answer 

boxes? 

Yes. The answer boxes in Xodo work well - the red borders are visible and 

the boxes are opaque to that handwriting guides are hidden. Users can 

TAB between answer boxes. 

 

 

http://feedback.xodo.com/knowledgebase/articles/1185256-keyboard-shortcuts
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Tick boxes? 

Yes. 

 

 

Drawing tools? 
Yes. Freehand drawing; draw square, circle, line, arrowed line, connected 

line, polygon, cloud. 

Annotation tools? Yes. Highlighter; strikethrough; underline; insert note, insert image. 

Spellchecker? 

 

No. When the Chromebook spell check is enabled, suspect mis-spellings 

are underlined in red but we could not find a way to actual use the 

spellchecker. Right clicking on the word (the usual method) gave the Xodo 

annotation menu, but not the spellchecker list.  

Literacy supports No. 

Computer 

dictation 
Yes, use Google Dictation. 

Type maths & 

science 

expressions 

No. 
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